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1. peatiikk Ulevaade

1.1 Lasergraveerimise l8ikestisteemi tarkvara tutvustus

Lasergraveeringu I6ikeststeemi arvjuhtimispinkide abil saavutatakse t6hus kontroll vastavalt
kasutaja erinevatele tootlemise viimistlusiilesannete nduetele.

Susteem sisaldab kontrollpaneeli ja juhtpaneeli, ning seda toetavat tarkvara. Kasutusjuhend
kirjeldab tarkvara kasutamist lasertdotluse tlesande taitmiseks. (Emaplaadi juhtmestiku ja
juhtpaneeli toimingutega tutvumiseks vaadake kaasasolevat kasutusjuhendit ja juhtpaneeli
juhtmestiku kasutusjuhendit).

1.2 Tarkvara toetatud failivormingud

Vektorvorming: dxf, ai, plt, dst, dsb ... jne.
Bittikaardi formaat: bmp, jpg, gif, png, mng,... jne.

1.3 Keskkonnanduded

(1) Windows XP ja uuem operatsioonisiisteem, soovitatav XP
CPU 586 uuem silisteem, on soovitatav, et P 11 vdi P IV uuem versioon (3) Soovitatav on
rohkem kui 1 G mélu mahtu.



2. peatikk Tarkvara pohilised operatsioonististeemid

2.1 Peamine liidese toiming
Parast tarkvara kaivitamist néete jargmisel joonisel ndidatud liidest.
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Mentiuriba: Selle tarkvara pdhifunktsioon on saadaval rakenduse Mendriba. Menulikask on

koige elementaarsem to0reZiim. Meniiliriba sisaldab: Dokument .
Joonistamine . Seadistus . To6tlemine . Vaade ja Abi.

Redigeerimine .

Susteemiriba: slsteemiribale on asetatud moned kéige sagedamini valitud kdsunupud
menudast.

Graafikariba: atribuut Graafika on graafikaoperatsioonide pdhiatribuudid, sealhulgas
graafiline asukoht, suurus, skaala, numbrite to6tlemine.

Redigeerimisriba: Redigeerimisriba vaikimisi asetus on toéopiirkonna vasakul pool.

Redigeerimisribale on asetatud need toimingud, mida kasutatakse sageli to6riistana, mis
muudavad toimingu paindlikumaks ja mugavamaks.

Joondamisriba: Valitud objektide joondamine.

Kihiriba: Valitud objektide kihi muutmiseks.



Juhtpaneel: Juhtpaneeli kasutamine mitme tlesande lasert66tluse 16puleviimiseks, Layer
parameetrite satted, telje juhtimine, té6tlemine ... jne.

2.2 Keele seadistamine ja teabe tootmine

Lisaks installimisprotsessile saate maarata tarkvara keele tibi, saate hdlpsasti sisse lilitada
erineva keele.

Kldpsake menudribal [Abi] -> [i%5 /Keel] menii laiendamine , valige vajalikud
keeletliubid.

Tootjateabe hankimiseks, et saaksime teile paremat teenust pakkuda, kldpsake nuppu Menau
Riba [Abi] -> [Teave RDCAM-i kohta]

Help(H)
About ROCAM bl
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e iy
DI L) I 1 IﬁOIOIDI 1111 l 1 I?OIOIDI 1 EngIISh ;
; , Other -

Tootja informatsiooni maaramise kohta vaadake (RDCAM-i tarkvara installimise
juhiseid)

Corp. Name: ’

Tel:]’ i

Addr: ’

|
|
= |
|
|

Web: I

QK

Dialoogiboksi allosas kuvatakse tarkvara praegune versiooninumber. Kuna tarkvara
erinevatel versioonidel vdib funktsioonide ja liideste osas olla moningaid erinevusi, saate
tarkvara versiooninumbri kaudu tootjatega hdlpsasti thendust votta ja nendega suhelda.



2.3 Lehekilje seadistamine

Kldpsake menudribal [Config] -> [Konfigureerimine] [Page setting] [Lehe seade]
kuvatakse jargmine dialoogiboks :

[Lehe laius] : Tarkvara lehe laius on tavaliselt seotud

I masina X laiusega.

page wikh: [0 o [Lehe kdrgus] : Tarkvara lehe kdrgus on tavaliselt seotud
Page height: }800 | mm . ]
; s masina Y laiusega.
Qrit
Gridspace: [50 | mom Kui olete emaplaadiga Gihenduse loonud, vormindatakse
Keyboard tavaolukorras tarkvara automaatselt masina praeguse t06 jaoks
Adust distance: :/1 mm Iehe SuurusekS.

Adjust ratio: ] 10

1o Kui tahvel pole Gihendatud voi vajate oma kohandatud lehe
— | suurust (nditeks lehe suuruse méaéramiseks materjali jargi),
Olor config

sackgone: | | Saate lehe suuruse imberkonfigureerimiseks kasutada lehe

workrea: [N | satet.
anid: [ [ Alusvérgu ruudu vahe]

adust angle: ; 1

Lok J [ concel | Alusvorgu ruudu vahe maaramine ja vérgu lubamine.

[Klaviatuur)

Kasutaja saab valitud graafika teisaldamiseks v0i pddramiseks kasutada nooleklahvi.
[ Varvi konfigureerimine]

Tdoala varvi madramine.

2.4 Faili avamine ja salvestamine

Tarkvara kasutab rld-failivormingut, et salvestada graafiline teave, erinevate kihtide
kihiparameetrid ja graafiliste elementide to6tlemisjarjestus.

2.4.1 Ava fail
Klopsake menttd [Fail] -> [Ava] vGi kldpsake nuppu, kuvatakse jargmine
dialoogiboks :



Open. . .
EHEEQ: | w FHRE 0) >« @&k B
Select file
S W [Default rld | 17@ |
IR D |14 | iy
I~ PAREAHTH ®) A

(2) Valige fail (nt Default.rld), klopsake nuppu [Open] [Ava] .

2.4.2 Salvesta fail (1) Kldpsake mentitid [Fail] -> [Salvesta] voi klépsake nuppu

H , kuvatakse jargmine dialoogiboks :

fRAFH

PX

BEEQ: | FHRZ 0

- - BB

[ Default. r1d

Input file name

A

B =1 DD e Faul t r1d]

—

| 77 ) |

REFXE (D) |RLaser Files(.r1d)

&l B

(2) Sisestage redigeerimisvéljale faili nimi ja seejarel kldpsake nuppu

[Save] [Salvesta] .



2.5 Failide import ja eksport

Kuna see tarkvara on rld-vormingus, tehakse muude materjalide kasutamiseks voi

redigeerimiseks importimine. Parast Eksport kasutamist muu tarkvara graafiliste failide

korral.

Toetatud failivorming impordiks: dxf, ai, plt, dst, dsb ... jne Toetatav failivorming

eksportimiseks: plt

2.5.1 Failide import

Kldpsake menuid [Fail] -> [Import] ,

dialoogiboks. Valige fail ja klGpsake nuppu [Open] [Ava] .
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vOi kldpsake nuppu

. Kuvatakse jargmine

Q shoel2. plt Q 1. plt
] #22. 91t ] IR p1t
] R p1t o] 8. P18
IV Breview
B ) Il\irplme. plt T e B ’
IR (D) ISupported Filesl _:_J HLiH

¢ Valige [Preview] [Eelvaade] ,

valitud faili saab kuvada.

Enamiku vektorfailide puhul imporditakse andmed automaatselt vastavasse RDCAM-

tarkvara kihti vastavalt kihi kirjeldusele.

Mone eridokumendi puhul, nditeks DST / DSB, imporditakse andmed praegusesse kihti.



2.5.2 Failide eksport

Kldpsake mentud [Fail] -> [Eksport] voi klépsake nuppu H kuvatakse ekspordi

FA

]3]

EEREEO: | & sT

a1 151

| Lso4s-. ST

]

~ e @k E-

v Preview

THEW:  [Abudiel IST

(& Open 'l

2R @) [Supported Filesl

Current

dialoogiboks. Sisestage faili nimi ja klGpsake nuppu [Salvesta) .

2.5.3 Faili parameetrite seadistamine

File Parameter @

Import Setting
PLT Precision: S
DYF Unit: MM
[[]1mport Dxf text info
[)smooth curves
Auto close curves .
Close error{mm): ['Ul ‘
Combine lines
Combine error{mm}: ‘[0'1
Export Setting:
- B
Export Precision(%s): {30 1
Velocity Unit: | mmfs | v
ok ] [ cancel |

PLT tapsus: vastavalt algse plt-faili tapsusele, et valida
sobiv imporditksus.

Sujuvad kdverad: vektorfaili importimisel
tasandatakse algsed kdverad automaatselt. Kui
originaalne graafika on sile vdi kui soovite silutud efekti
korduvalt reguleerida, vdite selle nupu tiihistada. Arge
tehke silumiskdveraid, see voib vahendada impordi
tootlemise aega.

Automaatse sulgemise kéverad: Lahitolerantsi jargi
automaatkontroll ja suletud kdver.

Kombineerige jooni: Vastavalt thinemistolerantsile
automaatselt thenduvad kdverad.

Varvikaart lulitub automaatselt halli skaalale : Kuna tavatingimustes on graafika hallil

skaalal.

Kui imporditud bitikaart on varviline, saab selle halltooniks teisendada.



Dxf-tekstsdnumi importimine : Kui kasutaja vajab ainult Dxf-graafilist teavet, mitte failis
olevat tekstiteavet, siis arge seda kontrollige.

Ekspordi tapsus: ekspordi plt-faili voi valjundfaili tapsus.

Kiirusthik: Tarkvara toetab kahte tidpi Kiirusihikuid: mm /s . m/ min. Kiirusiihik on
valitud vastavalt kasutusele. Pérast selle valimist muutub liideses parameetrite kiirus koos
sellega.

2.5.4 Pildigalerii

Sageli kasutatavad graafilised pildid salvestatakse kasutusmugavuse tagamiseks
pildigaleriisse.

Image library EI.-.@,‘C
LB BIEViEW Image number: 1

[wew ]|
[ ]

wewdfe

Newlib ][ Dellib Add Image Del Image
Exopt options
[¥] Original size 60.000
Lock scale

2.6 Graafika loomine

4 Joon

Kldpsake mentitid [Joonista] -> [Joon] 7 vOi kldpsake Redigeerimisriba, lohistage
hiirt ekraanil, et saaksite soovitud joone tdmmata.Vajutage horisontaalse voi vertikaalse
joone joonistamiseks klahvi ,,Ctr]*.

4 Poldjoon

Kldpsake mentitid [Joonista] -> [Poliijoon] s voi klopsake Redigeerimisriba.
Lohistage ekraanil hiirt, et saaksite soovitud poliijoone joonistada.

¢ Ristkilik

Kldpsake menuitid [Joonista] -> [Ristkiilik] m vGi kldpsake Redigeerimisriba.
Lohistage ekraanil hiirt, et saaksite joonistada vajaliku suurusega ristkuliku.



Ruudu joonistamiseks vajutage hiirt lohistades klahvi "Ctrl".

® Ellipse

: . A o
Kldpsake mentitid [Joonista] -> [Ellipse] vOi kldpsake Redigeerimisriba.
Lohistage hiirt ekraanil, et saaksite joonistada soovitud suurusega ellipsi.
Ringi joonistamiseks vajutage hiirt lohistades klahvi “Ctrl”.

& Punkt

: . . S
Kldpsake menuitid [Joonista] -> [Ellipse] vOi klbpsake Redigeerimisriba.
Klbpsake ekraanil hiirt, et saaksite punkti tommata.

& Tekst

Kldpsake menuitid [Joonista] -> [Tekst] A vGi kldpsake nuppu Redigeerimisriba.

(3 TrueType font: ‘ T Tahoma v 1 wWidth: |50 £
(O 5HX font: i Fs.SHX Sy ‘g | mm
Text Line space: ‘U rm
["]Enable variable text
Height: ~ |100 mm ( OK | [ Cancel ]

Seejéarel kldopsake joonistusalal mis tahes positsiooni hiipikakna tekstisisestuse dialoogiboksi.

Valige fondi sdna, sisendi tekstisdna, seejarel madrake suurus, laius, sdnade vahe, reavahe.
Klopsake uuesti [OK]



Tarkvara toetab ka muutuvat teksti, seda on vaja vastavalt teatud reeglitele muuta. Iga
valjundi tootlemise ajal tuleb teksti automaatselt muuta. Stisteemi muutujate jaoks on
tdéhemargi tudp, kuupéevamuutujad ja seerianumber.

Muutuja on kuupéev, mil iga kord, kui to6tlemine toimub, votab arvuti praeguse ajavéljundi
ststeemi. Tarkvara pakub klientidele mitmesugust kuup&evavormingut. Kasutajad saavad
méarata ka kuupdeva rande, seda saab teha 3 erineval moel: p&evade kaupa, kuude kaupa,
aasta kaupa. Pakendil mérgitud aegumiskuupéevani saab toodet kasutada.



O 5Hx font: A Fs.shix Chor snacei |0 - ELER
Text Line space! [B mm ey 9999
Enable variable text %
S v
_Bria Enable prefix ZERO
Fix: |
::Fz [‘i [C]Enable sM array
Start SN: éuoon MNumber Space “””
Current SM: 0000 % 1 H l —
SN Inc: ﬁ | : — =
o | (O | L ===
[ OK ] [ Cancel ]
Height: 100 mm [ Apply ] [ OK ] [ Cancel ]

Kui ABCO001DEF t66tleb korduvalt, siis ABCO002DEF, ABCOO3DEF kuni ABC9999DEF
seerianumbririihmani.
[Prefix] : seerianumbri prefiks, naiteks ABC juhib margijada.
[Suffix] : jarelliite jarjenumber, nditeks DEF on mérgijada jarel.
[Start SN] : millest alustatakse teatud arvu tootmist, naiteks tuleb alustada seerianumbriga
0001.
[Praegune SN] :

pracgune 100, mill

seerianumbreid saab

|
@ TrueType font: | B Tahoma v idth: |50 %
: | : whi 50|« kasutada ka selle
O shix for: i Fs.shux Char space: |0 | mm . o .
= seerianumbri tootlemiseks
Text Line space: '_U mm o
vajaliku voolu
[¥]Enable variable text madramiseks Nagu
| | . )
e e ~ | | seerianumbririihma
12Hour[HH:MM][09:09] 5 e .
ézzgm%:::m%gg:ggfl] tootlemisel, lekke
(all]g H H
24Hour[HH:MM][09:09:21] - tOOtlem|Se| UkS, kU|d

American Date[02/07/2012]

Chinese Date[2012802 H07H] -
Chinese Date Time[2012802 A 07 madratud praeguse
Chinese Time[098F0945321%1]

European Date Time[07/02{2012a. | | seerianumbri kaudu
European Date[07.02.2012]

Week vearl07/lzizniz 09:09:21) w | | todtlemise, mitte alguse
oets [0y |0 |3 | searianumbrite
Height: m (e | [_oc ] [ comcel ] |tegemiseks, sest mdnel
juhul kui

seerianumbri rihm nduab korduvat to6tlemist, nimelt seerianumbrini, tuleb minna tagasi
seerianumbri algusesse.



[SN Inc] : intervallinumbrile saab maarata jarjekorranumbri. Naiteks
tootlemisel seerianumbrilt 0001 kuni 9999 on juurdekasv 1.

Kui peate valjastama ainult paaris- v0i paaritu numbri seerianumbri, saate seada
juurdekasvuks 2.

[ Luba lahtestamine] : seerianumbri t66tlemine seerianumbri lahtestamiseks madratakse

[current SN] praegune SN automaatselt olekuks SN start [Start SNJ .

Néiteks nduavad korduvat tootlemist vahemikus 0001 kuni 9999, seerianumbrid, nii et selle
saab téhistada lahtestusena 9999, seerianumbrina, 9999 seerianumbri to6tlemisel muutub
tekst automaatselt vaartuseks 0001.

[ Luba eesliide ZERQ] : kui see ei vii nulli, eemaldab siisteem automaatselt null-digitaalse
seerianumbri. Néaiteks seerianumbrid, kui nullist saab ABCO001DEF, saab ABC1DEF. Kuid
vaarib markimist, et kui soovime véljastada seerianumbri ABC1DEF, ABC2DEF kuni
ABC9999DEF, ei saa me seda teha.

[ Kaivitage SN] saavutamiseks seadistatud vaartusele 1, kuid tuhistamise [lubamiseks
saavutage eesliide ZERO]
kuna seerianumber on algusest peale madratud numbriga, mis maarab ka oluliste numbrite
arvu, nagu naiteks kui seerianumbriks on seatud 1, on seerianumbrite jarjekorra muutus
1,2,3,4,5,6,7,8,9,0,1,2,3,4,5 ... Seerianumber ei muutu kiimneks, sest tegelikul seerianumbril
oli 1.

[Luba SN-numbrijada] numbrijada kaupa, téodeldes korraga rohkem seerianumbreid.
Naiteks:

0001 0002 0003  pérast partii tootlemise seerianumbrit 0015 0014 0013
0006 0005 0004  jattes vahele jargmise grupi 0007 0008 0009
0016 0017 0018 0016 0017 0018

& Jaadvusta

Klopsake mentiid [Draw] -> [Capture] [Joonista] -> [Jaadvusta]

| tEkE

HiB:

BiH

Kui arvuti on thendatud pildiseadmega, kuvatakse dialoogiboks. Pérast selle valimist saate
pilte koguda maaratud seadmest.



2.7 Objekti valik

Graafika joonistamise ja redigeerimise kaigus tuleb kdigepealt valida objekt.
Objekti valimisel on selle keskel kujuline mark ,,x” , ja seda timbritseb kaheksa
juhtimispunkti.

Klopsake mentiid [Draw] -> [Select] [Joonista] -> [Valige] Ri vBi kldpsake
nuppu Redigeeri, lulituge olekusse ,,Vali”. Nuld saate objekti valida. Jargnevalt on vélja
toodud viis tldpi valimismeetodeid :

@ Kldpsake meniiid [Edit] -> [Select AllY (Shortcuts Ctrl+A) [Redigeeri] ->
[Vali koik]  (Otseteed Ctrl + A), valige kdik objektid.

# Uksiku objekti valimiseks kldpsake ekraanil hiirt

4 Valige objekt valimiskasti abil

Vajutage hiirt ja lohistage seni, kuni kast valitakse objektiga kokku.

# Valitud objekti suurendamine / valitud objekti vahendamine

Valitud pildi suurendamine : Valitud objekti suurendamiseks vajutage klahvi ,,Tostuklahv*,

kldpsake nuppu voi valige ruut. Miinusvalik : Vajutage klahvi ,, Tostuklahv®, valige valitud
objekt voi kldpsake seda.



# Valige objekt vastavalt kihile

St | [Cmrts | I indon? | S | IRt Ao |

Layer Mode Speed Power Qutput
B 100.0 300 Yes
B 100.0 300 Yes
I  cut 100.0 300 Yes
B 1000 300 Yes

[ Up J [ Down ]

Paremkldpsake valitud kihil ja seejérel valitakse k8igi kihis olevate objektide osa.
2.8 Objekti varv

Obijekti varv, mis on objekti kontuuri varv. Valitud objekti varvi muutmiseks voite kldpsata
kihiribal oleval vérvinupul. Vajutatud nupu vérv on praeguse Kihi varv.

2.9 Objekti muutmine

Objekti muutmine hdlmab peamiselt: objekti asukohta, orientatsiooni ja suurust. Kuid ei
muuda objekti p6hikuju ja selle omadusi.
Obijekti teisendamiseks pakub siisteem mugavat kasutajaliidest. Kasutaja saab joonistamise

= 00 t+
tooriistaribal objekti peegeldada ja poodrata A< B8 2 O.

Voite kasutada ka Objekti atribuutide tooriistariba

X% 445,91 ¥ 235,959 100 | = :
: m: = mim 'C:.-': E ﬂ ¥ o % processwoilt |

299,205 208,549 | mm | | 100




Graafika teisendamiseks ja kopeerimiseks voite kasutada ka spetsiaalseid teisendustooriistu.

|work | output | Doc || user | Test ] Transform |

[+ o

Position:

H: [449.933 mm

V: |350 mm




2.9.1 Objekti pilt

Objekti pilt po6rab valitud objekti horisontaalselt voi vertikaalselt. KI6psake nuppu Muuda
At

, po6orake valitud objekt horisontaalselt.

Kldpsake nuppu Redigeerimisriba ™ , pdorake valitud objekt vertikaalselt.

| work | Output | Doc || user | Test | Transform |

40

Ratio:

[z 1 00 Yo

Vi 3100 e

Mirror:

[ ] pisproportionate

Fl—Fl=71
O © O
FIE=F|=F]

[ Apply to copy ]

JE—.

Apply |

V0i labi peegli teisendustodriistade, horisontaalse ja vertikaalse peegli ning kopeerimise
juurde.

2.9.2 Objekti p66ramine

Valige objekt, seejarel topeltkldpsake hiire parema nupuga >



Kui soovite podramist lohistada, saate liikuda hiirega |I'I| ja seejérel vajutada vasakut

klahvi.

Pooramisnurga reguleerimiseks hiirt lohistades jargneb sorestikuvaates kontuur.

2

445,91

Y 299,208

mm
mm  f

............

ST

235,959

i

100

205,549

mm

100

:j: Eﬂ (¥ 0 | % Processmoi[t |

V/0i sisestage podramisnurk otse tooriistaribale Objekti atribuudid.



;-';;.'u'ork Output‘Doc User Test [ Transform |

|

Rotate:

H: |0

Center:

He (44591 | mm

v 500,791 | mm

[JLock rotate center
[Jrelative center

O
O

-

00O
© O
0-0O

Apply to copy |

Apply ]

V/0i kasutage teisendamiseks podrlemise muutmise tooriistu. Pooretel saab teisendustooriista

seada poorlemiskeskmele ja lukustuskeskmele.

2.9.3 Objekti suurus

¥ 445,91 |mm #K (235.989 | mm | 100
¥ol2e9.208 mm  f 208,549 mm | {100

:j: E @ (¥ o 9% processmoi[t |

Saate méérata valitud objekti suuruse ja keskpositsiooni.



[ Test | Transform |

\W;:urk | output | Doc | User

+| o]

Size:

[ Apply to copy ]

| Apply J

V/0i kasutage objekti suuruse muutmiseks tooriista kuvandi suuruse teisendamiseks. Saab
muuta suurust, valida, kas lukustada kuvasuhe, ja méérata positsiooni muudetava objekti

suhtes.



2.9.4 Kallutamine

| Work | Output | Doc | User | Test | Transform |

+ o]

0
Skew:
H: E] 1 Deg
[Jise anchor point
[ Apply to copy ]
[ Apply ]

Objekti saab kallutada teisendustdoriistade abil. Sellega saab seada kaldeankrut ja
kaldenurka.

Kallutamine pBhjustab bitikaardi moonutusi ja praktiline rakendamine toetab ainult
kallutatavat vektorgraafikat.

2.9.5 Objekti massiivi replikatsioon

Klbpsake nuppu Redigeerimisriba [3 , Vvalige objekt, mida soovite kopeerida. Seejarel
oo
kldpsake nuppu EO ilmub jargmine dialoogiboks :

fArray copy ‘
XNum: 1 XSpace: 0.000
YNum: 1 YSpace: 0.000 IE‘E
[ Bestrew... H Ok ][ Cancel ]

= Uhe graafika laius (mm) I Uhe graafika kdrgus (mm)



Saate massiivi replikatsiooniobjekti paigutada erinevates suundades. Kopeerimise suund
pohineb algsel graafikal. Nagu nditeks massiivi suuna paremal allosas valimine, siis ilmub
vasakusse ulanurka. Kui see asub vasakus tllanurgas, kuvatakse paremas alanurgas algne
graafika.

Parast graafilise jada numbri ja vahemaade mé&&ramist kldpsake nuppu

[Apply]l [Rakenda] , néete tegelikku graafikajada.
Graafilise jada vahesid on kaks vormi: keskpaigutus ja servapaigutus.
Valige keskpaigutus, seejarel [X kaugus (mm)] . [Y kaugus (mm)] , mis tahistab kahe
graafilise keskme kaugust.
Kui te ei vali keskpaigutust, siis [X kaugus (mm)] . [Y kaugus (mm)] tahistab
graafilise serva kaugust.
Keskkaugus X = serva kaugus X + objekti laius Keskmine kaugus Y = serva kaugus Y +
objekti kdrgus.
Kahe arvutusmeetodi vahel vahetamine: [X kaugus (mm)] . [Y kaugus
(mm)] arvutatakse automaatselt.
Kldpsake nuppu [Bestrewing breadth] [Parim jaotuslaius] ,tarkvara arvutab graafilise
jada numbri automaatselt vastavalt tooriku suurusele . laius , koérgus . X kaugusja'yY
kaugus.
Vahemiku reguleerimiseks saab sisestada véartused otse ja klGpsake nuppu

[ Apply]l [Rakenda]
Objektide vahekauguse reguleerimiseks saab vajutada ka suunanuppe.
Markige ruut [Center] [Keskpunkt] . Seejérel koondatakse pérast objektimassiivi
replikatsiooni (paljundamist) graafika toopiirkonda. Graafika suumivaate saamiseks kerige
hiirerattal.
Graafika panoraamvaate saamiseks lohistage hiirt.

2.9.6 Objekti asetamine soovitud asukohta

Asetage objekt, et hdlbustada vaadet vdi orienteerumist. Tarkvara pakub jargmisi tooriistu:

+
= valitud objekt paigutatakse lehe keskele, see tdéhendab, et objekti keskpunkt langeb
kokku lehe keskmega.

T? ﬂ EJ' li valitud objekt asetatakse lehele vasakule, paremale tilemisele, paremale,
vasakule alla, objekti vasakusse tlanurka, paremasse ulanurka, paremale alanurka, paremale,
vasakule alanurka ja vasakule tlanurka, tUlesse paremale, alla paremale, alumisse paremasse,
alumisse vasakusse nurka.



2.10 Objekti joondamine

Objektide valimiseks kl6psake joondamise tooriistadel.
2 E20peow 20 M =20 H
Taooriistad sisaldavad:

= & 0) pd | | _ o
Vasak joondamine , Parempoolne joondamine . Ulemine
joondamine . Alumine joondamine

'—' == Ll . . . . . .
¥ Horisontaalne keskjoondamine . Vertikaalne keskjoondamine,

keskjoondamine

H T

Horisontaalne vordne kaugus, Vertikaalne vordne kaugus

= m H Sama laius, Sama kdrgus, Sama suurus.

Vordlusobjekt :

Kui vajutate klahvi ,, Tostuklahv* [Shift] ja valite Ukshaaval objekti, on vdrdlusobjekt
viimane objekt.

Kui valite objekti valimiskasti jargi, on vdrdlusobjekt kdvera viitenumber.

2.11 Objekti vaade

Teisaldamine : Kldpsake meniiid [Edit] -> [Move] [Muuda] -> [Teisalda] véi
+
kl6psake nuppu “* Siis hoidke hiire vasakut nuppu joonistusalas all ja lohistage paanil.

Kujutise suurendamine : Kldpsake mentiid [Edit] -> [Zoom Out) [Redigeeri] ->

[Suurenda] voi klGpsake nuppu ™

Iga klBpsatus suumib kujutist joonisealal tihe korra.
Liigutage hiir joonistusala keskele ja kldpsake, iga hiirekldps suurendab kujutist joonistusala

keskel the korra.

Kujutise vahendamine : Kldpsake mentitid [Edit] > [ Zoom



In] [Muuda] -> [Vahenda] v&iklpsake nuppu  * lga hiirekldps vahendab kujutist
joonistusalal ks kord. Liigutage hiir joonistusalale ja kl6psake, iga hiirekldps hiire
asukohaga joonistusala keskel vahendab kujutist iks kord.

Vaate valik : Klopsake mentid [Edit]-> [View Select] [Muuda] -> [Vaade valik]

vOi klBpsake nuppu * Liiguta hiir joonistusalale, hoia hiire vasakut nuppu all ja lohista
seda joonistusalal. Kuvatakse kriipsuga piirikarp, vabastage hiire nupp, siis kuvatakse
kriipsuga piirikarbi alal olev piirkond suurima osakaaluga joonistusalas.

Kuva leheraam : Kldpsake meniiid [Edit] > [View Page Frame] [Redigeeri] ->
[ Kuva leheraam] vdi kldpsake nuppu * Leheraam kuvatakse téielikult.
Andmeraami kuvamine : Kldpsake meniiiid [Edit] > [View Data

Frame] [Redigeeri] -> [Kuvaandmeraam] v&i kldpsake nuppu ™ Valitud objektid
kuvatakse taielikult.

2.12 Grupeerimine ja eraldamine / rihmadeks jaotamine

Redigeerige graafikat ja monikord peab see olema osa kogu toimingust (naiteks mitmerealise

teksti trikkimiseks).
Meetod: Valige graafikagrupp ja seejarel mentti [Edit] / [Group]) ( [Un

Group) [Redigeeri] / [Grupp] ( [Un Group] ) vdi valige otse tooriistariba

g i



2.13 Oluline tooriist

Siin on moned sageli kasutatavad todriistad. Nende oluliste tooriistade abil saate graafikas
oleva dokumendi korrapdrasemaks muuta ja valjundi tootlemise kiiremaks muuta.

2.13.1 Kasitsi sorteerimine, I6ikepunkti ja I6ikamise suund

Tarkvara pakub kasutajatele mugavat tooriista kasitsi sorteerimiseks. Valige [Edit ] >

[ Set cutting property] [Muuda] -> [Maara IGikamise omadus] . Avaneb atribuudi
I6ikamise dialoogiboks. Koiki kasitsisorteerimise, 16ikepunkti ja 16ikamise seaded saab selles
dialoogiboksis valida.

Set cutting property @
s e e g e S R mmmmmen . | [ ReOrder ] [ Reverse ] [ ReOrder ]

NO Name NO Name
Element1
Element2
Element3
Element4
Element5
Elements

@b W N e

[¥] showpath jJ L]
x|

Kuva tee
Kdoigepealt kontrollige “Show path”, see kuvab graafika praeguse I6ikamise jarjekorra ja
IGikamise suuna.

Kasitsi sorteerimine

Valige @ Seda nuppu kasutatakse toimingu muutmise voi vaatamise praeguse oleku
vahetamiseks. Seejérel saate joonistada voi kldpsata graafika kuvaalal asuvat graafikat (voi

kldpsata thel pikslil voi mérkida mitu pikslit). Parast graafika valimist valige see




graafika, mis suunatakse teise loendisse ja mida t06deldakse esimese algkujutisena.
Esimesele algkujutisele jargnevad korduvad toimingud, et kogu graafika jéarjestada.

Graafilise tootlemise suuna muutmiseks valige hiirega graafika graafikakuval voi loendis. Ja

-
siis kldpsake - . Muutke I6ikepunkti.

Set cutting property @
ReOrder H Reverse H ReOrder ]

NO Name NO Name
Element1
Element2
Element3
Element4
Element5
Element6

1

2

3

»»»»»»»» B e e TR R E L SEEC PP L. N
5

ot 6

[¥] showPath _ﬂ_l il

Valige graafika, mis muudaks I6ikepunkti, see nditab kdiki praeguse graafika s6lmi. Valige
lahtepunkt, topeltkldpsake hiirt, see muudab alguspunkti

praeguse graafika. Parast koigi muudatuste I6puleviimist kldpsake - , muudatuste

tulemuse saab salvestada.

Lisaks I6ikamise omadustele pakub tarkvara ka méningaid tooriistu l16ikekorralduse,
I6ikamissuuna ja 16ikepunkti muutmiseks.

Valige|— tooriistaribal voi klopsake mentitkasku [Edit) -> [Show Path] [Muuda]
-> [Kuvatee] .
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Kasitsi sorteerimine
Valige esimene algkujutis (primitiiv), millel tuleks I6ikamisjarjekorda muuta, siis kuvatakse
objekti omaduste ribal praeguse algkujutise I6ikamise seerianumber.
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Sisestage seerianumber otse todtlemisnumbrisse, seejdrel vajutage klaviatuuri klahvi “Enter”
vOI kldpsake joonistusala, 16ikamisjarjekord muutub.

Tootlemissuuna muutmine Loikesuuna redigeerimisreziimi sisenemiseks kldpsake nuppu
[ Edit] > [Set cut direction] [Redigeeri] -> [Maara I6ikamissuund] . Seejarel saate
topeltklGpsata valitud graafika mis tahes positsioonil.

Loikepunkti muutmine

Loikepunkti redigeerimisreziimi sisenemiseks kldpsake nuppu [Edit] > [ Set cut

point] [Redigeeri] -> [Maara IGikepunkt] . Seejarel valige kdver, mida tuleks muuta,
saate 18ikepunkti muutmise I8puleviimiseks topeltkldpsata sdlmel, mille soovite 18ikepunkti
seada.



2.13.2 Sisseldigatud / valjal6igatud joonte seadistamine ja redigeerimine

Koverate joonistamisel vGi importimisel pole vaikimisi kdveral Uhtegi sisseldigatud /
valjalBigatud joont.

Kui soovite lisada sisselBigatud / véljaldigatud ridu, valige objektid, seejarel kidpsake nuppu
[ Edit] -> [Edit cut in property ] [Redigeeri] -> [Sisseldike omaduste

redigeerimine /muutmine]  véi . limub jargmine dialoogiboks.
Cut in and out setting |ﬂ&
Cutin
| |Enable

Length(mm): 3
Angle(degree): 45
Cut out

| |Enable 7
Length(mm):  °

Angle(degree): 45

[ Ok ] [ Cancel

Sissedigatud / valjalGigatud joonte tegemiseks tuleb kdigepealt lubada sisselbike / véljaldike
funktsioon. Sissedigatud / véljaldigatud jooni on kahte tulpi: sirge ja kaar.

Sirge joon saavutatakse kolmel viisil:

Ldika nurga all sisse: 16ika sisse joon ja alusta IGikamist kindlasse nurka, vastupéaeva nurk on
positiivne.

Ldika sisse keskel, joone lI6ikamise alguspunkt on keskel.

Loika keskelt sisse, sirge 16ikejoon on keskelt alguspunktini ja pikkus on seadistusega
maéaratud.



Cut out line

Cutin line X

Sisseldigatud kaare pikkus on seadistusega méératud.
On kahte tutpi kaari: sisseligatud / véljaldigatud kaari nagu on ndidatud jargmisel joonisel:

Emane Isane

ValjalBigatud joonte to6tlemine toimub samamoodi nagu sissel@igatud joonte todtlemine.

2.13.3 Tee optimeerimine
Tee optimeerimine on peamiselt vektorgraafika Gmberkorraldamine.

Kldpsake meniiid [Handle) -> [Cut optimize] [Tootle] -> [Ldike optimeerimine]
[n]

véi ® ilmub jargmine dialoogiboks.



Cutting optimize handle

[Jorder of layer

Inside to outside
ISingIe inner to outer v ]
Block handle
Height: 5. Dir: |Up to bott v
[]start paint optimize

Auto determine start point and direction

’. Ok ] [ Cancel ]

Kldpsake menttd [Edit] -> [Show Path] [Redigeeri] -> [Kuvatee] voi kldpsake

nuppu l_ et naha I8iketeed enne ja parast todtlemist.
. i i

A

Laser head

Enne tootlemist Parast graafika tootlemist

Graafika 16ikejoon algab alati laserpeast.



2.13.4 Kdverjoonte silendamine

Mdne vahemtéapse kdvera puhul vaib see funktsioon muuta kdverad sujuvamaks ja tootlemise
sujuvamaks.
Kldpsake mentid [Handle] -> [Curve Smooth] v6i kidpsake "IAJ , kuvatakse

jargmine dialoogiboks.

Curves smooth @

Smoothness J 95% [CIpirect smooth

| | [ Apply l[FulIFrame][ Ok ][ Cancel ]

Lohistage sujuvat liugurit ja klopsake nuppu [Apply] [Rakenda] enne siledad ja parast
sujuvad koverad kuvatakse kdik dialoogiboksis.

Mustad koverad tahistavad algseid kdveraid ja punased kdverad téhistavad parast sujuvaid
kdveraid.

Graafikat saate vaadata hiirega lohistades.

Graafikat saab suuremaks suumida / véiksemaks suumida kerimisratta abil.

Suurima kuvamiseks kldpsake dialoogiboksis nuppu [Full Frame] [Taiskaader] ja
graafika niidatakse suurimana.

Parast viimistlusega rahulejaamist klopsake nuppu [Apply) [Rakenda] , kdveraid
toodeldakse sujuvalt vastavalt sileduse satetele.

Valige “Direct smooth” (viimistluse otsetee), saate kasutada mdnda muud silumismeetodit.
Silumismeetodi valikut tuleks muuta vastavalt tegeliku graafika vajadustele.



2.13.5 Kontrollige kdvera sulgemist

Kldpsake menutid [Handle] -> [Curve auto close] [Tootle] -> [Kdvera automaatne

sulgemine] , vdi kldpsake nuppu Siisteem , kuvatakse jargmine dialoogiboks.

Setting close error @

Close error (mm): |IHEY
=

Force to close

Ok 7 Cancel

Sulge veateade: kui kaugus alguspunktist 16pp-punktini on vaiksem kui on lahitolerants,
toimub kdvera automaatne sulgemine.

Jouga sulgemine: kdigi valitud kdverate kohustuslik sulgemine.
2.13.6 Kattuvuse eemaldamine

Klopsake mentiid [Handle] -> [Delete overlap)] [Tootle] -> [Kustuta kattuvus]

= I
vOi ilmub dialoogiboks.

Delete overlap lines @

[ JEnable Overlap error

Overlap error{mm): |-~

Ok [ Cancel ]

Tavaolukorras drge valige “Enable Overlap error” ,,Luba kattuvuse viga“. Eemalda
kattuvad jooned kui need on kahe rea vordlemisel hea kokkulangevuse astmega. Kui peate
kattuvad read kustutama, peaksite valima “Enable Overlap error” ,,Luba kattuvuse viga” ja
madrama kattuvuse. Uldiselt arge lubage kattumist veaga, mis on liiga suur, et véltida
juhuslikku kustutamist.



2.13.7 Kdverate liitmine

4
Kldpsake menttid [Handle] / [Combine Curve] voi 7.+ ilmub jargmine

dialoogiboks:

Setting combine error

—
A

Combine error{mm):

[. Ok ) [ Cancel ]

Tarkvara liidab valitud kdverad automaatselt, kui nende kdverate liitumistolerants on
vaiksem kui kombineerimisvea seadistus.

2.13.8 Bitikaardi tootlus

Kl6psake nuppu [3 ja valige bitikaart, seejarel klopsake mentiid [Handle) -> [Bitmap

o ) I . EMP
handle] [Tootle] -> [Bitikaardi tootlus] voi klGpsake nuppu Sisteemiriba

Bitmap handle

Width: 500 Pixels
Height: 750 Pixels
H Resolution: Pixelsfinch
¥ Resolution: 96 Pixelsfinch

Brightness: 0.0%
- iy |

3
Fontrast: 0;91%

v

[Jinvert color
[] Set output resolution

Resolution(pixelsfinch) %5

[Jpither

I Apply to view ] I Apply to source ]

[ Get outline ]

HSaveas ”FuIIScreen” Ok “ Cancel ]




Dialoogiboksi paremas tlanurgas kuvatakse praeguse pildi teave.
Pange téhele, et horisontaalne eraldusvime ja vertikaalne eraldusvéime muutuvad
lohistamisskaalat kasutades.

[ Apply to view] [Rakenda vaatele] : Praeguseid seadeid kasutatakse ainult eelvaate
jaoks, ilma, et see mdjutaks algset bitikaarti, vajutage nuppu [Cancel]l [Tuhista] ,
bitikaart naaseb algse pildi olekusse. Seet6ttu kasutage ainult efekti reguleerimiseks. Kuid see
I&henemine nduab rohkem aega ja maluruumi.

[ Apply to source 1 [Rakenda allikale] : Praeguseid seadeid kasutatakse otse algse
bitikaardi jaoks, nii et isegi kui klGpsate nuppu [Cancel]l [Tuhista] ei saaka algse
pildi juurde naasta. SeetOttu kasutatakse seda peamiselt mitmeastmelises t66s ja selle sammu
praegune toimimine on vajalik kui néiteks tldpildid tuleb muuta halliks skaalaks. See vdib
séésta jareltoimingu arvutusaega.

[Save as] [Salvestanimega] : Siilitage eelmise toimingu tulemused. Lisaks rakenduse

[ Apply to view] [Rakenda vaatele] kasutamisele saab ka jargneva tootlemise
hdlbustamiseks eksportida.

[Grayscale]l [Hallskaala] Uldiselt pdhineb muu pildito6tlus hallil skaalal , nii et
enne kasitsemist saate halli skaala toodelda ja seejarel kldpsata nuppu [Apply to
source] [Rakenda allikale] . Halli skaala jaoks, kui varvipilt hdivas vaiksemat
mélu, luuakse suur pilt samm-sammult, teatud maaral méalupuuduse valtimiseks.

Varvipildi jaoks reguleerige kontrastsust ja heledust, millel on jargneval vérvipikslite
segamisel kujundi to6tlemise abistav efekt. [Kui vérvipalett on piiratud, luuakse varvipikslite
segamisel vajaliku varvi illusioon].

Kontrastsuse reguleerimine:

Enne tootlemist Peale to6tlemist



Umberpééramine:

Teravus:

Enne to6tlemist Peale to6tlemist
Virvtoonimiseks on kolm meetodit: vorgugraafika, punktgraafika, must-valge graafika.
Vorgugraafika

Vorgugraafika peab kohanduma vorgu suurusega ja sobib paremini materjalile, mis ei ole
korge eraldusv6imega vOi vastasel juhul reageerib laser suhteliselt aeglaselt.

Sobiva vdrgusuuruse saamiseks saate reguleerida pildi eraldusvéimet ja vorgutihedust. Mida
suurem eraldusvdime, seda peenem vorgustik.

Mida suurem on vOrgu sagedus, seda vaiksem on vorgu suurus. Mida madalam vérgu
sagedus, seda suurem vérgu suurus. Uldiselt on pildi eraldusvdime 500-1000 ja netosagedus
30-40 joont.
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Tapigraafika

Hea halli skaala tapne graafiline jéudlus sobib paremini suure eraldusv8imega materjalile ja
laser reageerib Kiiresti.




Must-valge graafika

Enamasti on varvipildi muutmisel mustvalgeks halb efekt, kuid mdne selge kontuurpildi
jaoks on seda siiski véga lihtne kasutada.

Bitmap handle
Width: 52 Pixels
Height: 30 Pixels
H Resolution: 1000 Pixelsfinch
V Resolution: 1000 Pixels/inch

Brightness: 0.0%

0
Contrast: 0.0%
| s
[ nvert color
[ set output resolution

Resolution(pixels/finch) | 1000

[T bither

Net graphic

Dot graphic
Black And White

@) Gray scale

Sharpen
[ Apply to view ] [ Apply to source ]
[ Get outiine ]

I | [Crdsacen | [_saveas J[ ok J[con ]

Ulevaate saamine:

Kontuurigraafi ekstraheerimiseks kldpsake nuppu “Get outline” "Saada Ullevaade". Jargmise

pildina




2.13.9 Eelvaate tootlemine

Kldpsake menuiid [Edit] -> [Preview] [Redigeeri] -> [Eelvaade] voi kldpsake
nuppu Susteem E .
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Tarkvara toetab to6deldavate dokumentide eelvaadet ja eelvaate kaudu saate pOhiteavet.
Naiteks tootlemise tegeliku véljundi tee, tldine to6tlemisaeg, kauguse tootlemine.
Too6tlemisprotsessi saab simuleerida.

Lisaks praegusele redigeeritud faili eelvaatele saate eelvaadet vaadata ka failide kohta, mis on
salvestatud kui rd. fail.

Rd-faili eelvaade:
Topeltkldpsake graafikakuval. Valige hipikakna dialoogiboksist pilt, mida soovite
eelvaadata. Ja siis avage



Open

Look in: | bD My Documents v‘ € ? e [y

() Adobe Scripts ,_fj My eBooks () Source Insight
()Baidu [ZMy ISO Files \2) Visual Studio 2008
{)Corel User Files [ﬂ My Music AN
(CJFILTERIT4 User Settings  ((2)My Pictures
[O)KSDStore My QQ Files

)My Designs (@1ry webs

L . 5 2
File hame: “ l | Open l
Files of type: | *.rd v} [ Cancel ]

[] Open as read-only

Tarkvara toetab ka eelvaate parameetrite maaramist.

Paremkldpsake graafikakuva alal Anywhere, kuvatakse konfiguratsioonimenai. Valige

hiipikakna jargmine dialoogiboks "*Config"

Background
Back color: - Font color: -

Draw color{Power)

oo || O W oo
Simulate color{Power)

Idle color .

Anchor

Full window

Config O Top left O Top right

. ] (O Bottom left () Bottom right
Horizontal mirror

YVertical mirror

Graafika vérvi saate eelvaadata, et see vastaks energia tegelikule véljundile. Kasutajad saavad
holpsalt vaadata, kas kihi energia vastab toele.



2.13.10 Andmete kontroll

Valitud andmete kontrollimiseks parast graafikat, klopsake mentitkaskudel [Handle)K

"Ry

» [Datacheck] vdi kldpsake stisteemil

Data check @

Close check end
'7Check close Mot find unclose curves
Self-cross check end
[Jauto close Error{mm): Mot find self-cross curves
Cross check end
Check self-cross Mot find cross curves
Overlap check end
Mot find overlap lines
Check cross
Check overlap
[ ]Enable error Error{mm): |0 01 Check

Andmete kontroll, l&hem vaatlemine, tlevaatus ja thinemisandmete ristumiskoht kattuvad
kontrolliga. Kasutaja saab valida kontrolli, probleemi kontrollimise pérast andmete
sisestamist, dialoogiboksist parempoolse osas, ja samal ajal probleeme valitud
olekugraafikas. Check-> Kontroll-> korduvalt vélistatud Error-> Viga-> kontrolliprotsess,
kuni kdik andmed vastavad to0tlemise nduetele.

2.13.11 Paralleelsete joonte genereerimine

Valitud andmete paralleelsete joonte loomiseks kldpsake mentiiikaskudel [Handle] /
[ Offset poly]

Offset poly @ ; o e ;

Offset{mm); |01 mm [ Delete artwork o~ \J \ 4 =

®1In O out () auto InjOut

[ Ok ] [ Cancel ]




Originaali graafika jaoks on punane joon, roheline joon on kahaneva graafika sees.

2.13.12 LGP disain

Kldpsake mentil kiaske [edit) /[LGP design 1 [Redigeeri] / [LGP kujundus] v&i
kldpsake joonistamise tOoriistariba, saab alustada peegelduse kujundamise tooriistade
kasutamist. Tooriistad on péikese to6tlemise blokeerimiseks spetsiifilised, neil on iseseisvad
funktsioonid, néiteks kasutaja kes ei ole seotud péikeseplokiga voib selles osas sisu
tootlemisest eirata.

Valides tabula rasa kujundustooriistad peame kdigepealt kujundama refleksi juhendi
kontuuri. Valides tabula rasa kujundamise tooriistad peame kdigepealt kujundama
OutlinePlay kanali tabula rasa kujundamise todriistad, kdigepealt peame kujundama
peegelduse juhendi kontuuri.

Tooriistades on vaikimisi 200 X200 ristkilikukujulise tabula rasa kontuur. Kasutaja saab lehe
"slisteem" tooriistades kasitsi luua tabula rasa kontuuri kuju.



LGP CADBCAM System.

Create LGP outline

Width: 200.0 Height: 200.0

@ Rectangle Ellipse

Apply

Standardse seade loomiseks v8ib kasutada ristkulikukujulist v6i ovaalset kontuuri.
Kasutaja saab importida ka péikese kontuurina hea graafilise kujunduse. Kl6psake
nupul "Tabula rasa kontuuri juhtimise sissejuhatus”. Saate valida, kas dokumendi
kontuur on péike. Peate markima, et kontuurifail peab olema suletud graafika, vastasel
juhul kustutatakse siisteem automaatselt.

LGP Size(mm):
Width: 200.000 Height: 200.000

V| Lock ratio

Apply

Kui impordi suurus on nduetele vastav, saavad kasutajad muuta kontuuri suurust ja
saavad seadistada kas j&&b valget serva.

Graafika Ulevaade on valmis, nuld saab alustada tabula rasa vorgu suurendamist.



Parameter |Qutput | Systen|

LGP Point(mm)
Width: £.0000 Height: 1.0000

UpGrad: 0.0000 UpGrad: 0.0000
DownGrad: 0.0000  DownGrad: 0.0000
leftGrad: 0.0000  LeftGrad: 0.0000
RightGrad: 0.0000  RightGrad: 0.0000

Space(mm)
Up: 2.0000 Grad: 0.2000
Down: 20000 Grad: 0.2000
Left: 2.0000 Grad: 0.2000
Right: 2,0000 Grad: 0.2000
Base line
X: 0,000 Y: 0.000
Dislocation
V|Row V| Column
Light source
[ Left [ Right
[]Top | Bottom

l Create LGP }

Posion: CurentPosit v | UsB:Auto |

Start ] [Pause/Continue ][ Stop ]

GoScale H CutScale ” Preview ]

|
{ SaveUFle || OutputUFle | Download |
|

Export LGP design ]

Vork on jagatud kuuel viisil: horisontaalne,
vertikaalne joon, elliptiline, ristkulik, vork
ja ruudustik.

Valgusallikaga seotud ldhtejoonega saab
kasutaja reguleerida lahtejoont vastavalt
ajavalgusallikale. Ulaloleval joonisel on
punane vorgumark marker lahtejoonena.
Kasutajad saavad hiire viia baasjoonele,
kldpsata hiirt ja seejarel lohistada lahtejoont
kui soovivad vajalikku positsiooni
paigutada.

Kogu juhtjoone refleks on jagatud neljaks
piirkonnaks, mis on uleslingi algtaseme
maéaratlusest kdrgemal ja allaltli
maéaratletust allpool. VVasakpoolse veeru
vertikaalne lahtejoone maaratlus on vasakul,
parema veeru maaratlus on paremal.
Seadistage vastavalt vdrgu suurus ja
vahemaa vorgus Ules, alla, vasakule veergu,
parempoolse veeru algvaartus ja muutuse
maéar, mis voivad kasutajatel lubada tabula
rasa efekii.

Ruudustiku saamiseks peab maarama
kasutamise toimingu / veergu mis
vbimaldab ilmuda ruudustikul.

Rakenduse mugavuse huvides saab valguse
seadistamise stisteemis, kui valgusallikas on
standardne, valida valgusallika, seejarel
seada vorgu parameetrid ja ei ole vaja
lahtejoont kohandada. Siis ilmub ka
peidetud baasjoon.




Vorgustik Elliptiline

Vorgusilm Ristklik



Horisontaalne joon Vertikaalne joon

Vasakpoolne valgusallikas Parempoolne valgusallikas




LGP cut/Engrave

Speed(mm/s): _  [] Default
MinPower(%): 30.0 Default
MaxPower(%): 30.0
[V]1s blower on
Scan predsion 1016 dpi
OnDelay: 0000 ms
OffDelay: 0.000 ms
Outline cut
Enable outline cutting Is blower on
Speed(mm/s): iﬁa Default
MinPower(%): 30.0 [ Default
MaxPower(%): 30.0
OnDelay: 0.000 ms
OffDelay: 3—060— ms
Array parameters
XNum: 1 X Space: 0.000
¥ Num: 1 Y Space: 0.000
Create LGP

Position: |Current Posit v ||  USB:Auto |

Start ||Pause/Contine || stop

]

saveUFile || OutputUFie || Download |

Goscale || cutscale | Preview

|

[
[
[
[

Export LGP design

J




Valgus ulaltpool Valgus altpoolt

RN AR

horisontaalne, vertikaalne joon, vork, elliptiline, ristkulikukujuline on vérgu
skaneerimisreziim.

Skaneerimisreziim, minimaalne energia, maksimaalse energia iildine viértus on sama ja
viivituse vaartus on 0. Skaneerimissuisteemi tépsuse reguleerimine: mida tihedam
skaneerimisjoon, seda tdpsemad on skaneerimisjooned ja tapsus on madalam kui
skaneerimisjooned on hdredad.

Vorgu tootlemismeetodid on Idikamine ja mitte tdpne skaneerimine ning neid saab
reguleerida vastavalt tegelikule efektile, maksimaalse ja minimaalse energia valgusluliti
viivitusele, Uldiselt kdige vahem energiat kulub maksimaalsest energiast veidi
madalamale seadistades.

Kui teil on vaja servapeegeldust 18igata, saab kasutada kontuurldiget. Ldikeparameetrite
ja Uhiste Idikamisandmete kohta on Seaded identsed.

Kui soovite valida Massiivtootlemise rohkemate paneelide tootlemiseks, saab selle
seada massiivitootlemise parameetritele. Massiivtootluse suund masinal on alati
algussuund vastupidises suunas.



3. peatukk Ststeemi seaded

Enne valjundgraafika valikut on vaja kindlaks teha, kas stisteemi seaded on diged. Kldpsake
mentitid [Config] -> [ System Setting] [Seadistamine] -> [Sisteemi seadistamine]

Config(S) | Handle(w)  View(y
System Setting
File Para Setting

Page Setting
Password Setting

Graph Hatch
Show Array
Show grid

3.1Uldséatted



General settings | System Info

Axis Mirror Laser head
Absolute coordinate
(V] Axis X Mirror ®© © @ i
® ® © Map for pen axis:
[¥] Axis Y Mirror @A A 6
Small circle speed limit Scanning(Reverse interval
Diameter{mm) Speed{mm/s) Speed(m... Reverse... Offsetr...
1.100 10,000 50.000 11.000 2.000
2.100 20.000
3,100 25.000
4,100 30.000
6,100 35.000
8.100 40.000
< | 10 [ » < | 1] [ »
| Add.. || Deete | | Add.. || e |
Teljepeegel

Teljepeegel

vasakul all.

Kui masina nullpunkt on vasakul (lal, siis ei pea X-telg peegeldama, vaid Y -telg peab
peegeldama.

Kui masina nullpunkt on tleval paremal, peavad mélemad, nii X-telg kui ka Y-telg,
peegeldama.

Lisaks saab seda funktsiooni kasutada ka muude peeglirakenduste jaoks.

Uldjuhul p&hineb peegli telje suund masina tegeliku asukoha v&i kodu tegelikul asukohal.
See vaikimisi koordinaatide susteem on Descartes'i koordinaatide siisteem, ja null asub




File(F) Edit(E) Draw(D) Config(S) Handle(W) View(V) Help(H)

LPHEF o0 acaacaaqmees vwEsHSED B %%

-0.087 | 3.624 (100 ] % | = |
:;1.7%5 mt}"z::éz mm Z, ﬂﬁ‘ O o P rrocessiiof2 1 E 8 W 3 ‘H 180 B8 ‘ K 71 Kk EB‘ +)[ auto Jfcutmnjout][ chek ][ oraw ‘
.....2:5ﬁ|‘...|..Z:Uﬁ....|..1-.@.,..|..l:ﬁq.‘.....":Eﬁ‘......°-."_95|....|.:°-.ﬁ|.,..|.:1-.‘ﬁ[~ H
= = ~ | Work |output [Doc [user | Test [Transform|
- layer  Mode  Speed  Power  Output
&
g
.|
lo]
Cw )

Line/column setup

 Aooo,

Num  space Disocation  Miror
x: [1 0.000 |0.000 H v
0.000 0.000 H

Lasernork
[ stert ][ Pause/continue ][ stop |

(s L

[ savetourie ][ urieoutput [ Downioad |

[ClPath optimize
[] output select graphics

Device

Mot XEE x0Ty N\ [

Rogo,

868
888 Postton: Current positon ~
I o 5 [ UsB:Auto )

-EEEEN EEEEEE 0

FEa .

Laseri pea
Laseri pea asukoht tahendab laseri pea asukohta graafika suhtes.

Uleval vasakul Uleval keskel Uleval paremal



Ja wWgz  wly
‘ 012 hasda o0 00
|

Vasakul keskel Keskel Paremal keskel
92 W98 W
Q0 Qo oo

Vasakul all All keskel Paremal all



Absoluutne koordinaat

Saate seda suvandit otse kontrollida, kui soovite, et graafika asukoht graafika kuvaalal
vastaks tootlemise tegelikule tookohale. Siis ei ole graafika asukoht enam seotud laserpea
tegeliku valjundasendi ja orientatsioonipunktiga, vaid peab alati kinnituspunktiks
mehaanilist alguspunkti.

Put pen to paper axis mappings / Telje kaardistamine / maaramine

Kui masinatele on paigaldatud pusiplatvorm ja tekib toé6tlemisvajadus erinevatel platvormi
kdrgustel.

Vaikese ringi Kiirusepiirang

Tootlemisel otsustab tarkvara automaatselt, kas praegune peab tO6ringi Kiirust piirama,
seejarel vali Kiiruse maaramine vastavalt ringi 1abim6ddu suurusele. Kui parameetrite
seadistus on sobiv, parandab see oluliselt véikeste tooringide kvaliteeti. Seadistamiseks
klGpsake nuppu [Add) [Lisa] , [Delete] [Kustuta] ,
[ Modify]l [Muuda] konfiguratsiooni.



Véikesel ringil on védiksem kiirus kui minimaalsete vaikeste miinimumraadiusega
ummarguste ringide loetelu piiravate reeglite kiirus raadius, minimaalne raadiusering vastab
kiiruse valjundi kiirusele.

Kui on maaratud maksimaalsest kiirusepiirangust suurem Kiirus, loetleb kiiruse ringi, on
kiirus seotud ainult kihi Kiirusega.

Kui kiirus on loendis, méarake valjundkiirus loendi jérgi.

Kui kihi parameetrite piiramisega maéaratud kiirus on kiirem kihis madratud kiirusest,
vajutage valjundkihi kiirust.

Skaneerimise tagasilook

Laserskaneerimisel toimub graafilisel viisil, kuna masina rihma pinge 16tk v6ib skaneeritud
graafika serva ebalihtlaseks muuta. Seetdttu suureneb rihma tagasilook serva parandamiseks.
Sellel on teatud Kiiruse jaoks konkreetne tagasilook. Uldiselt mida suurem on kiirus, seda
suurem on tagasilook.

(1) Tagasil6dgi lisamine
Kldpsake nuppu Lisa, ekraan avaneb nagu on naidatud joonisel

Madrake kiirus ja tagasilook, kldpsake nuppu OK, vaartus lisatakse tagasiloogi loendisse.

' S‘canningb(Reverse interval) @

Speed{mm/s) |
Reverse interval(mm) 0

Offset repay(mm) 0

[ Ok ] [ Cancel

(2) Tagasiléogi muutmine

Topeltkldpsake hiire vasakut nuppu skaneerimisel (vastupidine vahe) on vaja muuta ploki
vastupidise sisestamise kliirensit, nagu joonisel naidatud hipikaknal.



Scanning(Reverse interval) =3

Speed(mm/s) 50
Reverse interval(mm) -11

Offset repay(mm) 2

[ Ok ] [ Cancel ]

Liideses saab muuta vastava tagasiloogi praegust kiirust.
(3) Tagasildogi eemaldamine

Paremkldpsake tiksuse kustutamiseks tagasiloogis skaneerimise (vastupidise tihiku) plokki
ja seejérel kldpsake kustutamiseks nuppu [ Delete] [Tthista] .

3.2 Susteemiteave

Setting

\-Céneréi‘sérfﬁﬁgs | System Info ]

Vendor password: ' [ Input ]

Mainboard version:

Emaplaadi tootjate teabe kohta peab parameetrite vaatamiseks sisestama parooli.



Setting

| General settings | System Info |

Total on time{hour :min:s): |

Total processing time{hour:min:s):

Previous processing time{hour:min:s:ms): J

Total laser on timethour:min:s):

Total processing times:

¥ Total traval{m): I

Y Total travel(m): ‘

Mainboard version:

Toodaeg kokku: emaplaadi todtamise aeg kokku

Kogu tootlemisaeg: kogu téotlemiseks kuluv aeg, sealhulgas hippelise liikumise aeg.
Eelmine tdotlemisaeg: viimase tootlemise aeg

Kogu lasertootluse aeg: lasertootlemise aeg

Tootlemiste aeg kokku: 16petatud todtlemiste arv, vélja arvatud sundl@petatud téotlemine.
X kogu liikumine: mootori X kogu kéik.

Y kogu liikumine: mootori Y kogu kaik.

Emaplaadi versioon: praeguse kontrolleri versioon.

Uuenduste funktsioon:

Kui plaadil on lisafunktsioone, pakuvad tootjad varskendusfaili (*. Bin vormingus), kasutaja
saab emaplaadi tdiendamiseks uuendusfaili alla laadida. Pérast tdiendamist peate enne
tavaparast kasutamist kldpsama juhtpaneeli nupul "Lahtesta” ["Reset"] emaplaadi
l&htestamiseks.



3.3 Kasutaja parameetrid

work | Output | Doc | User |Test | Transform

= cut parameters -
Idle speed(mm/s) 300.000
Idle Acc(mmjfs2) 2000.000 :
Idle Delay(ms) 0.000
Start speed(mm/s) 20.000
Min Acc{mm/s2) 500.000
Max Accimmy/s2) 2000.000

Acc factor{0%-200%) 80
GO Acc factor(0%-200% 120
Speed factor(0%-200% 80
Key setting

=] Sweep parameters
% Start Speed(mm/s) 20.000

w CHavk Crmmdfirara ic) 20 00N

Open i Save | Read Write

Enne kasutaja parameetrite maaramist tuleb tahvli parameetrid Iabi lugeda.

3.3.1 Cut / Loike parameetrid

Cut parameters =
Idle speedimm/s) 300.000

Idle Acc{mm/s2) 2000.000

Idle Delayims) 0.000 -
Start speed(mm/s) 20.000

Min Acc{mm/s2) 500.000 —
Max Acc(mmj/s2) 2000.000

Acc factor(0%-200%) 80
GO Acc factor(0%-200% 120
Speed factor(0%-200% 80
Key setting




Tuhikaigu Kiirus: see parameeter maarab max. masina to0 ajal kdigi kiirte kiirgamata
liinide kiirus. See parameeter ei tohiks olla madalam X-telje ja Y-telje imberltlitumiskiiruse
madalamast ega Uletada suurimat maksimaalsest. X-telje ja Y-telje kiirust. Kui seadistus ei
kehti, méé&rab regulaator selle parameetri automaatselt tlaltoodud vahemikku. Suhteliselt
korge tuhikaigul litkumise kiirus voib lihendada kogu joonise td6aega, samas kui liiga suur
tihikaigul litkumise kiirus v8ib pdhjustada liini véarisemist, seetdttu peaksite seadistamisel
arvestama koigi asjakohaste teguritega.

Tuhikaigu Kiirendus: vastab tuhikaigu kiiruse, 6hu- ja dhusuunalise Kiirenduse
kiirendusele, kui seadistate selle liiga aeglaseks, ei pruugi tegelik kiirus saavutada
tihikaigule seatud vaartust. Kui see on liiga kiire, ei pruugi mehaaniline struktuur vastu
pidada, mille tagajarjeks on varin. Veidi suurem kui dhuldikekiirenduse tldine kiirendus.
Loikamise kiirus: vastab I8ikekiiruse kiirendusele (I16ikekiirus on kihtide kihiparameetrite
Kiirus).

Acc factor: tuhikaigu kiiruse vastav koefitsient, mida suurem on suhe, seda suurem on
tihikaigu kiirus.

Go Acc faktor: vastav 10ikekiiruse koefitsient, mida suurem on suhe, seda suurem on
I6ikekiiruse fraktsioon: mida suurem nurga poorlemiskiirus, seda suurem on koefitsient.
Turning Speed / Pé6rlemiskiirus: vastava poorlemiskiirusega lI6ikamisprotsessis, languse
minimaalne kiirus, paljude hammaste to6tlemisel, kui graafika vdib olla sobiv
poorlemiskiiruse véhendamiseks.

Turning Acc / Poordekiirendus: peaks sobima podrlemiskiirusega.

Léikereziim: jagatud tdpseks l6ikamiseks, kiireks I6ikamiseks, tlikiireks 16ikamiseks,
kasutaja saab valida vastavalt tegelikele rakendustele. Naiteks tapsuse réhutamiseks valige
tapne 16ikamine, kiiruse réhutamiseks valige kiire 16ikamine.

Acc. reziim: see parameeter otsustab mootori kiirendus- ja aeglustusreziimi (S-reziim voi T-
reziim) tootamise ajal, mootor kiirendab ja aeglustub reziimis S aeglaselt ja sujuvalt ning T-
reziimis kiiresti ja suhteliselt sujuvalt; vaikimisi reziim on S-reziim.

3.3.2 Sweep parameters / Sagedusparameetrid



[=] Sweep parameters
% Start Speed(mm/s) 20.000
y Start Speed(mm/s) 20.000

¥ Acc(mmfs2) 3000.000

y Acc(mmjfs2) 2000.000

Line Shift Speed (mm/s) 150.000 ]
Scan Mode Comron Mode

Facula Size(S0~99%)  98.000

x alguskiirus, y alguskiirus: skannimise valjaltlitamise kiirus samm-mootori lohistamise
korral ei hakka 0-st kiirenema, vaid v@ib t66d alustada tooprotsessi lihendamiseks otse
Kiirusest, kuid kiirus pole liiga suur, ja kuna X, Y teljekoormus erineb Kiirusest, on tldine X-
telje algkiirus veidi suurem kui Y-telje algkiirus.

x Acc, y Acc: kui skaneerimiskiirus (kihtide parameetrites olevate kihtide kiirus) sobitub
skaneerimiskiirusega, kui see on liiga vaike, kannatab skaneerimise efektiivsus. Masina saab
seadistada vastavalt tegelikule struktuurile, koormustingimused varieeruvad. Kuna X-telje
koormus Y, on see palju suurem kui X-telje Y-telje kiirendusmodtur.

Rea vahe skaneerimise Kiirus: seda parameetrit kasutatakse spetsiaalselt max. skaneerimise
kiirusel, et nihkuda vertikaalselt Gihelt joonelt jargmisele joonele selle all. Kui skaneerimise
ajal on rea vahe liiga suur v@i plokiruum on plokkide kujundite skannimisel liiga suur, samas
kui iga rea voi ploki jaoks on vajalik tdpne positsioneerimine, v@ite seada rea vahe
skaneerimise Kiiruse suhteliselt madalale véaartusele. See parameeter ei tohi olla vaiksem kui
vastava telje huppekiirus liininihke ajal ega tohi olla suurem kui max. vastava telje kiirus
liinivahetuse ajal. Kui seadistus ei kehti, maérab kontroller selle parameetri automaatselt
ulaltoodud vahemikku.

SkaneerimisreZiim: valikus on kaks reziimi: iildreziim ja erireziim, ildreziimis pole
skaneerimise ajal mingit tootlust, erireziimis toodeldakse heledaid laike. Erireziimi
aktiveerimisel tuleks laseri vdimsust suurendada ja vastavalt sellele on valguslaigu protsent
vaiksem ja laseri vBimsuse sumbumine suurem, sama skaneerimisstigavuse saavutamiseks
peaks laseri vGimsus olema suurem. Erireziimi valimise eesmark on panna laser kiirgama
Kiiret suure vdimsusega kiirt ja lihikese aja jooksul. Stigava skaneerimise ajal vdib saavutada
lameda pdhja efekti, kuid kui valguslaike valesti reguleerida ei pruugi see mdju saavutada
ning suure voimsusega tooreziim ja lithike tooperiood voivad mdjutada laseri tooiga.
Vaikimisi reziim on tldreziim.



Facula Size / Facula suurus: Uldise valiku mustri skannimisel on kehtetu, kui valite
erireziimi, siis madrake parameetrid algusest. Parameetreid kontrollitakse vastavalt 50% kuni
99%.

3.3.3 Lahteparameetrid

=] Home para
Horne speed(mm)fs] 150.000
Auto home X Mo
Auto home Y Mo
Ato home z Mo
Auto horme U Mo

Lahtekiirus: See parameeter méérab, et masin pOtratakse tagasi algsesse asendisse, kui
suurema formaadi kiirus on liiga suur, saab masinal kiiruse lahtestada, kuid mitte liiga palju.
X, Y, Z, U Automaatne alglahtestus: telje alglahtestuse saab alglaadimisel madrata.

3.3.4 So6otmise Parameetrid

= Feeding para
Delay before feed(s) 0.000
Dealy after feedims) 0
Progressive feeding No
Progressive feeding repa 0.000

Viivitus enne s60tmist: sooteseadme kasutamisel saab ks kord enne sodtmist viivitada,
naiteks saab kasutaja korraldada materjali sorteerimist.

Viivitus parast sootmist: viitab materjali so6tmise seadmele, et jouda maaratud asendisse,
vajab seade enne tdotlemist teatud aja jooksul stabiilsust.

Progressiivne jark-jarguline soétmine: he liini asemele saadetav sdddatihematerjal on
s0otmise viis.

Progressiivse soote torge: sooteseadme kasutamisel voib esineda sooteliinil sdoteviga.



3.3.5 Go Skaala parameetrid

= Go Scale para
5o scale mode Close laser
Go scale blanki(rm) 0,000

Go skaala reziim: kolm reziimi - valguse punktid valjuvad piirist, avanevad ldigatud
piirid, nurgad.

Go skaala tuhi: Kaiguraam voib pdhineda pildi tegelikul suurusel dlevalt alla, veidi piiri
valge vasaku serva suunas, et tegelik graafika saaks tdielikult kujutatud.

See seadistus on juhtpaneelil kooskdlas piiriga seotud funktsioonidega, liikudes samal ajal
piiril sBltumatu tarkvaraga.

3.3.6 Muud parameetrid

=] Other
Array processing Bi-dir Array
Return position Qrigin I
Focus depthirmm) 0.000
Backlash X(mm) 0.000
Backlash Y {rnm) 0.000

Massiivireziim: saate valida pendelziimi ja {ihesuunalise reziimi.

Pendelreziim: massiiv jarjest ja edasi; tihesuunaline reziim: massiivi 1dikamine alati
iihest suunast teise. Kui valitud on iithesuunaline reZiim, on koigil massiiviiiksustel
tthesugused litkumisreziimid ja litkumise likviidsus, kuid see reziim votab rohkem aega
kui pendelziim. Vaikimisi reziim on pendelziim.

Tagasipositsioon: saate valida asukoha ja masina alguspunkti. See parameeter maarab
asukoha, asukoha ja masina lahtekoha, kus laserpea peatub pérast iga toimingut.
Viivitus enne so6tmist: sodteseadme abil, viivitus enne Uhte s66tmist, saavad kasutajad
madrata aja ja muu sarnase, naiteks korjamise protsessi.

Viivitus parast sootmist: viitab paigutatud etteandeseadmele saadetud materjalile,
vajadusele stabiilsuse jarele teatud aja jooksul parast tootlemist.

Fookuse sligavus: automaatse teravustamise toiming vastava paneeli leidmiseks.



Backlash / Tagasilook X, Y: kasutatakse masina ajami probleemidest tingitud
tagasiloogi kompenseerimiseks.

3.4 Dokumendihaldus

| Work | Output | Doc  |uUser | Test | Transform |

Number File Name Time(H:M:S:MS)

[ Read ][ Process [ Download

[ Delete H Cal time [ Upload ]

[ Delete Al

Read / Loe

Klbpsake nuppu Read / Loe, tarkvara suhtleb kontrolleriga, loe kontrolleris olevate
failide loendit.

Kui kontrolleri lugemine on dnnestunud, kuvatakse dokumendiloendis failiteave.



Download / Lae alla

Kldpsake nuppu Laadi alla, ilmub failidialoog, valige * .rd allalaaditud fail, seejarel
laaditakse fail kontrollerisse alla.

Allalaadimise 6nnestumisel véarskendatakse dokumentide loendit.

Process / To6tlemine
Valige dokumendiloendist toodeldav fail ja klpsake nuppu Process/Tootle. Kontroller kéivitab
maaratud dokumendi.

Delete / Kustuta

Valige dokumendiloendist fail, mille soovite kustutada, ja kldpsake nuppu Delete / Kustuta.
Kontroller kustutab maaratud dokumendi.

Kui kustutamine 6nnestub, varskendatakse dokumentide loendit.

Delete all / Kustutada kdik
Eemaldage automaatselt kdik kontrolleri failid ja varskendage dokumendiloendit.

Cal aeg

Emaplaat toetab failide tootlemist to6tundide suhtes. Valige tootatud tootundide arvutamiseks
fail ja kldpsake nuppu. Arvestus tuleb I6pule viia, juhtpaneelil palutakse arvutus I8pule viia.
Ja siis vajutage loendis kuvatud Loe nupule, to6aja jargi arvutamiseks.

Lisaks, kui dokumendit6tlustoiming on 1&bi viidud, hdlmab ka to6tundide teave tegelikku
tootlemist.

Uleslaadimine
Pdhiplaadil on valitud loetud vorgulihenduseta failid ja arvutisse salvestatud failid.



4. peatukk Valjundi t6otlemine

Laser work

| stat || Pause/Continue ||

Processing control

[ SaveTolFile ][ UFileOutput ][ Download ]

("] Path optimize

(g

Layer settings S

Device

Cut scale

Position:

| current position v |

Search device

USB:Auto

4.1 Search Device / Otsinguseade

Seadme saab Gihendada kahel erineval viisil: USB ja vorgu abil. Maarake hiipikakna USB-
pordi nupu kaudu ithenduse reziim ja valige ihenduse port.
Praegune asend: laseri pea enne tootlemist tagasi asendisse.
Algne ankur: laser suundub tagasi viimase ankruni, ankur vaib paneeli kilge Kinnituda.
Masina null: laseri pea tagasi masina nulli.

1P address setting 3

Machine name: machine

P92.K8. 1 .10
s

Device
Position:
( USB:Auto

Current position
Anchor point
Machine zero

Kui laserseadmega tihendatud arvuti ,

USB port setting

Machine name: machine

Port NO: Test

L]

Add Delete

Machine Port :
(2] machine Auto

[ add ][ opelete ][ modify ]

Machine P

machine 192.168.1.100

(s

saab automaatselt seadistada, maarab tarkvara
Uhenduse liidese tuvastamise automaatselt seadme liidesega




Kui arvutitihendusel on palju laserseadmete komplekte, klopsake markeruudul nuppu
[add] Lisa, ja valige, millist seadet tuleb kasutada.

Kldpsake nuppu [add] [lisa] v6i [modify] [muuda] , dialoogiboksist véljaspool,

nagu eespool naidatud, [add) [lisada] v&i [modify] [muuta]

saab klGpsata nupul [test] , parast seda, kui on kontrollitud, kas seade on seadmega

edukalt hendatud.

Kui arvuti on thendatud paljude laserseadmete komplektidega, kldpsake markeruudul
[add] Lisa, millega saab kasutada uut seadet.

Kui kldpsate nupul [add) [lisa] v&éi [modify] [muuda] , nagu kuvatakse

tilaltoodud dialoogiboksis [add)] [lisa] v6i [modify]l [muuda] .

Kldpsates [test] saab kontrollida, kas tuvastamine ja seadmete tihendamine on edukas.

Otsige praegu juba tihendatud seadet ja valige rippmentdist vastav IP

aadressiautomaat.

4.2 Layer Processing / Kihtide to6tlemine

Kdigepealt kontrollige meniitis [Handle] -> [Path optimize] [Tee optimeerimine]
vastavalt kihi jarjekorrale ja seejérel valjumiseks kldpsake nuppu OK.

Kihi jarjestus: kldpsates nuppu Ules, Alla saab muuta kihtide jarjestust vai suunata hiirt
kihi m&aratud asukohta lohistades.
Siin peate kontrollima valikut "Tee optimeerimine™.

4.3 Position / Asend

Laseri pea tagumise asukoha méaaramine pérast téotlemise 16ppu. Praegune asend .
Originaal ankur . Masina null.

Praegune asend: laseri pea enne t66tlemist tagasi asendisse.
Algne ankur: laser suundub tagasi viimase ankruni, ankur vdib paneeli killge kinnituda.
Masina null: laseri pea tagasi masina nulli.

4.4 Go scale / Sammu skaala . Cut Scale / Loike skaala

Naiteks [Go scale] puhul on jargmisel joonisel ndidatud, et tegelik graafika on Gmmargune
jaringist véljas olev punane ristkilik on véikseim ristkilik. KI6psake nupul [Go scale]
[Sammu skaala] ja laseripea tootab tiks kord mdoda ristkiliku kujundit.



A

Néiteks [Cut scale] Loike skaala puhul: joonisel on ndidatud, et tegelik graafika on
Ummargune ja ringist véaljas olev punane ristkilik on vaikseim ristkilik. KIdpsake nupul
[Cut scale] Loike skaala ja laserpea 16igab piki ristkilikut.

45 Start, Paus., Stopp. Salvesta Un faili. Un faili valjund .
Laadi alla

Start : véljastage praegune graafika masinasse t06tlemiseks.

Paus \ Jatka : Kldpsake nuppu Paus to6tlustdo peatatakse, kldpsake uuesti nupul Jatka
peatamist : Peatage praegune t66tlustoo

Salvesta Un faili :

Salvestage praegune fail RD-vormingus kasutades vargutihenduseta to6tlemiseks (Saab
taieliku vorgutihenduseta toimimise jaoks kopeerida teisele maluplaadile).

Faili valjundi tiihistamine :
Vorgulhenduseta faili véljastamine (RD-vormingus)

Parast vorguiihenduseta faili salvestamist kldpsake késul [Undo Fail Output] Tuhista
failivaljund, et valida téodeldav fail.

Lae alla:

Laadige fail alla kontrolleri méllu, seejarel saab kasutaja faili masinapaneeli kaudu
kaivitada.

4.6 Output Select Graphic / Véaljundi graafika

Parast Valjundi graafika kontrollimist valige ainult valitud osa valjund, selle asemel, et mitte
valja anda valimata osa.

4.7 Path Optimize / Tee optimeerimine
Parast kontrollimist Path Optimize valige tee optimeerimine enne véljundit automaatselt.

Kui olete Tee optimeerimise teinud voi pole vaja optimeerida, siis vOib Tee optimeerimine
valimata jatmine vahendada ooteaega.



4.8 Test

Work Output Doc | User l Test E—Tl-'ansform:

[ Current Position ] | %=2
=7
7=?
Axis Move :
(— (—, Offset{mm): i[lﬂ
¥+ 2+ —

Speedi{mm/s): 550
[ X- |[Home l X+ |[Home Power({%): .0

[ IMave from origin
[]1F Light

Teljega juhtimisel saab iga kord juhtida ainult Uhte telge. Saate madrata telje litkumise teabe,
sealhulgas litkumise pikkuse, kiiruse, laseri sisse- ja véljalilituse ning laseri vdimsuse.

Kui mérgite valiku ,, Teisalda paritolust” [Move from origin], tdhendab teie maaratud nihe
nihet masina nullini. Kui te ei kontrolli litkumist alguspunktist, tdhendab nihe nihet
praegusesse asendisse.

Néiteks X-telg, eeldades, et praegune asend on 100 mm, néiteks sammude kaugus on seatud
10 mm, siis liigutades tiks kord, uus asukoht on 110 mm, néiteks kontroll liigub
alguspunktist, litkumisajast, uus asukoht on 10 mm ja [Korduv Liikumine]

[Repeated Movement], siis asukoht enam ei muutu.

Markus. Vastavalt kontrolleri satetele ei ole absoluutne positsioon kogu laiuses negatiivne.
Kui valite [Liigu algsest asukohast] [Move from origin] ja madrate nihke véartuse
negatiivseks, tabab masin piirajat.



4.9 Valjundi seadistamine

hWork Output ‘};Doc | User Test 7 iTransf:oLml

[ ]Enable rotate engrave

Circle pulse: { IC | Help |

Diarmeter{mm): L -

Speed(mmjs): lL

[]Enable feeding B ]
Feeding Count: j |
Distance{mm): ‘[ ( '
[]Backlash reapy optimize
[ ]Enable offset of Laser2
% |C y: |0

4.9.1 Poorlev skulptuur

[Enable rotate engravel [Luba podrdgraveerimine] : Parast graveerimise lubamist
pdhineb Y-telje tegelik tapsus 1abimdddul ja sammul pééramise kohta, et see sobiks
automaatselt Y-telje impulsi tdpsuse seadistusega. Lisaks muutub ka pealiidese to0piirkond.

[Diameter] [Labimdot] : osade labimG6du suurus.

[ Step per rotate] [Samm poorde kohta] : Impulsi arv vastab tooriku péorlemisele.

[Test] : testimise kiirus.

[Speed] [Kiirus] : testige t60 Kiirust.

Selle Gilesanne on hdlbustada kasutajatel osade ja erineva suurusega tooriku véljavahetamist,
kui toorik pole enne kasutamist vaga erinevas mdddus. Kui tooriku suuruse erinevus on
suhteliselt suur, on soovitatav muuta mootori sammu lahendamise rakendust.
Poordgraveerimine toimub ainult péorlemistelje kasutamisel Y-telje kasutamise
asendamiseks.



4.9.2 SHote seadistamine

Voo kasutamiseks peate kdigepealt voo lubama.

Parast sootmisparameetrite seadistamist annab voll s6otmispikkuse ja korrake protsessi, kuni
to6tlemisaeg jouab s6otmise arvuni.

Kui masin pole varustatud so6tmisseadmetega, valige uldjuhul s66tmise keeld.

4.9.3 Tagasiloogi kompenseerimise optimeerimine
Kui masinal on ruumi (naiteks tihendi 16ikamise graafika nihkumine), saab seda kontrollida.
4.9.4 Optilise 2 migratsioon

Kui vajate laserite koost6od, tehke samad graafikatootlusprotsessid, tavaliselt selleks, et
kasutada optilist 1 graafika asukoha maaramiseks. Siis kui optiline 2 kattub tépselt optilise
1-ga, tuleb optilise 2 nihe optilise 1 suhtes tpsustada.

Seda kasutatakse tavaliselt masina kahes erineva véimsusega lasertorus, kuna kahe lasertoru
vBimsused on erinevad, saavad need taita erinevaid funktsioone.

Kui mdned masinad on varustatud kahe erineva voimsusega lasertoruga, siis esimene
vastutab I6ikamise eest ja teine vastutab skulptuuri eest.



4.10 Kihi seaded

Work | Qutput | Doc | User

| Test I Transform[

Layer Mode Speed Power Qutput
B ot 100.0 300 Yes
B o 100.0  30.0 Yes
B 100.0 300 Yes

[ Up ] [ Down ]

Line/column setup

Num space Dislocation Mirror
x: 1 0.000 0000 |[[H [v
¥ 1 0.000  0.000 Elx [Flv

{ Virtual array H Bestrew... H Adjust '

4.10.1 Veerud Massiivi graafilise tootlemise mugavaks seadistamiseks.

X number ja Y number on veergude ja ridade massiiv. X-intervall ja Y-intervall on vastavalt
veergude ja reavahe massiiv. Intervalli ja dislokatsiooni reguleerimine on massiivi paigutus.
Reguleerige graafilise paigutuse lubamisel tdpsemalt X-, Y-intervalli, saab reguleerida
vahetult intervalli ja dislokatsiooni alla, teha graafikat valitud olekus ja seejarel liikuda
reguleerimiseks tles voi alla klahvi abil ja hiirt saab kuvada, muutes reguleerimisprotsessi
tapsuse suuremaks. [Bestrewing width] [Parima leviku laius] : vastavalt laiuse
suurusele ja kasutaja seadetele méaratakse rea vahemik, maarates kdige enim loetletud
valjundit (s.0 X-numbrit) ja mitu rida (s.t. Y-arv). KlGpsake nupul [Bestrewing width] ,

kasutajaliides nagu on ndidatud joonisel:



Bestrewing breadth X

X breadth{(mm): 2

Y braddth(mm): 2

[ Ok ] [ Cancel

Madramise jargi saab tarkvara automaatselt arvutada kogu jarjestus numbri ridade laiuse.

[ Dislokatsioon] : méne graafika korral v8ib imberpaigutamisseade paigutuse
kompaktsemaks muuta.

[Peegel] : objektid selle horisontaalses vdi vertikaalses suunas

[Reguleerimine] : kui maarata mani vaiksem liikumine, saab reavahe ja dislokatsiooni
kauguse jatkamiseks klGpsata Reguleerimine.

[Virtuaalne massiivjada] : pérast sobiva massiivjada leidmist, mis on valitud graafika
kopeerimiseks, saab kopeerida terve mustrijada.



Layer Parameter

Load parameters from library ’

alll
1
=
s

ever: |

1 il

Is Output: ‘;»Yes 7]
Speed(mm/s); 100 [ Default
If Blowing: ﬁviYes ‘ vj;
Processing Mode: ?-Cut l v/
Min Power(%) Max Power (%)
1. 30 30 [ Default
@l2: 30 30
Open Delay: 0 ms
Close Delay: 0 ms
(V] Laser through mode
Through power: 50.0 %
b [ Ok ] [ Cancel

[Rakendus kopeerimiseks]

kopeerimise rakendus vdib juba graafikamassiivi dubleerida.
Kihtide loendis saab topeltkldpsuga sisekihi redigeerimiseks minna kihi parameetrite

dialoogiboksi.

Artikli vasakpoolne varv on praeguse graafikakihi esindaja. Erineva varvi valikuks voib olla
juba erinevate kihtide, Uhekordselt muudetud parameetrid mitme kihi vahel.

Kihi parameetrid on jagatud kaheks osaks: tldkasutatavad kihi parameetrid ja keeratava kihi
parameetrid. Uldkasutatavad kihi parameetrid on kdik toimivad kihi parameetrid, olenemata

hea graafikamassiiviga valitud graafika kopeerimiseks, moni

sellest, milline kihi to6tlemise thtip on.

Suletud kihi parameetrite muutmisel muutub ka kihi to6tlemise tulp,ja muutuvad ka

vastavad parameetrid.




4.10.2 Laserskaneerimise parameetrite seadistamine

Layer Parameter
A I [ Load parameters from library ]
- Is Output: eres ‘ v:
Speed(mm/s): 100 [T Default
If Blowing: Yes [+l

Processing Mode:

cut

Min Power(%) Max Power(%)

50.0

[@]1: 30 30 [ Default
@22 30 30

Open Delay: 0 ms

Close Delay: 0O ms

[¥] Laser through mode

%

Through power:

=] ox

J [ Cancel J

Laser: tarkvara graafika to6tlemise tehnoloogia parameetrite erinevate kihtide eristamiseks.
Skaneerimise todtlemismeetodite jaoks on rohkem sama kihi bitikaarte ja tervikuna
pildivaljundina, kui loodame, et iga bittikaardi Uksikvéljund, voib see olla graafika, mis on
vastavalt paigutatud erinevasse Kihti.

Valjund: on kaks vBimalust: jah ja ei. Valides selle, véljastab vastav kiht to6tluse. Valige
,,el ja tootlust ei valjastata.

Kiirus: eesmargile vastav tootlemiskiirus.

Ldikamise jaoks on vajalik aeglasem todtlemine, seda parem ja sujuvam joon. Mida
Kiiremini todtlemine toimub, seda halvem on trajektoori joone sujuvus.

Too6tlemine skaneerimisega on aeglasem, samasuguse energiaga skaneerimise sugavusel, ja
paksu jaljega vahendab eraldusvdimet.

Mida kiiremini sama energiaga skaneerida madalal stigavusel, suurenevad ka detailide
moonutused. Too6tlemiseks parandamiseks on peamine muudatus tthi litkumise Kkiirus.

Kui kontrollite "vaikimisi vaartust", siis on kiirus seadistatud juhtpaneeli jargi.

Puhur: masinal on véline ventilaator ja ventilaator on lubatud, siis kui valite "on", siis selle
kihi andmet66tlus avab ventilaatori, vastasel juhul ventilaatorit ei avata. Kui te ei ava
ventilaatorit. pole vahet, kas valida jah voi ei.



Tootlemismeetodid: madrab vastava kihi to6tlemise meetodid,;

Kui praegu on valitud vektorikiht (s.o varvikiht), sisaldab see kolme valikut:
laserskaneerimine, laserldikus, laser rbi;

Kui praegu on valitud tutu kiht (nimelt BMP kiht), on seal ainus valik: laserskaneerimine.
Laser 1, laser 2: vastab pohiplaadi lasersignaalidele 1 ja 2 laseri véljundi suunas. Kui see on
ainult peamasin, on teine lasertee mottetu.

Minimaalne vdimsus, maksimaalne véimsus: véaartuste maar vahemikus 0 kuni 100,
laserprotsessi tugevuse protsessis: Suur vaartus, laser on tugev, vaike véartus, laser on nork.
Minimaalne v8imsuskadu suurema vdimsuse korral on alla selle vdi vordne.

Erineva to6tlustlibi jaoks on erinev vaartused.

LOiketootlemiseks on tegelik voimsus I8ikekiirus ja faasi jargimine, kiirus ja energia on
samuti madal, suur Kiirus on suure energiaga, et saaksime garanteerida kogu energia
I6ikamise protsessis Ghtlaselt. Nii et minimaalne vimsus on vastava minimaalse energia
kiirus, minimaalne kiirus tldiselt O, kuid kui see on méaaratud, on kiirus minimaalne kiirus
stardikiiruseks. Maksimaalne vdimsus vastab kihi kiirusele.

Madra minimaalne vdimsus ja kdige suurem vooluhulk:

1> Minimaalne ja maksimaalne vdimsus on seatud samale véartusele, stinkroonne
reguleerimine. Kuni kdik 18ikekdverad on juba ilmunud.

2> Maksimaalne vGimsus ei muutu ja vahendage jark-jargult minimaalset voimsust, kuni
raske I0ikekdvera energia on kdige madalamal tasemel ja k6ik sidusosad saab valja
tootlemiseks t60delda.

3> Kui see ei anna veel kdige paremat tulemust, voib olla kdige sobivam suure vdimsusega
peenhaélestus ja korrake 2. sammu.

Kui see on labi 16igatud, pole minimaalsel vdimsuskaol ja maksimaalsel voimsusel, olulist
erinevust, saab seadistada sama vdimsuse.

Skaneerimisega tootlemisel, tavalisel skaneerimisel peavad olema minimaalse voimsuse ja
maksimaalse vdimsuse vaartused jarjepidevad. Kaldejoonisel on minimaalne vdimsuskadu
vastavate tegurite vdimsus, kdige suurem voimsus pdhjaosa vdimsus.

top




Minimaalne v8imsuskadu on laieneva joone algusosas detailselt margatav.

Minimaalne v8imsuskadu on ilmselt liiga suure kaldega, mis pole ilmne.

Tootlemise parandamiseks saab tasandamiseks maérata minimaalse vdimsuse ja
maksimaalse voimsuse.

Kui see on mérgitud "vaikimisi", maératakse voimsus, mille méarab tegelik voimsus.
Kldpsake nuppu "tdpsem” [[Advanced] tdiendavad seadistused], kuid saate seadistada ka
teisi kihi parameetreid.

Seal: 0.000 mm

Open Delay: 0 ms
Close Delay: 0 ms

(V] Laser through mode
Through power: 50.0 %

Tihend: Suletud I8ikegraafika tihend ei ole suletud, selle saab sulgeda
tihendikompensatsiooniga, kuid kui tihend on valesti paigutatud, ei ole kompensatsiooni,
kompenseerimiseks saab kasutada kliirensikompensatsiooni optimeerimist voi kasutada
kasutaja eelistustes tagasiloogi kompenseerimist Ava Viivitus; Medaljon aja / medaljoni
latentsuse jaoks.

Sulge viivitus: valguse sumbumine véljalilitamisel / valguse véljaltlitamise viivitusaeg.
Laseri ldbiv reziim: kui see on mérgitud, on valgusliliti viivitus digeaegne, vastasel juhul
on viivitusluliti nimetatud laseri liikumise valguse viivitus.

Labi jou: viitab esemete pressimisele Kiire t66 tGhiku aja jooksul.



Other layer parameters

[]Enable pen up and down

mm Read

mm Read

Speed:{mm/s): 100 l

Point ————
Dot interval(s) It l
Enable Laserz
Extend IO output
101
booiok..d [ Cancel ]

[Pliiats iiles ja alla] Kui masin on tdsteplatvormi paigaldanud ja peab toGtlemisel asuma
erinevas platvormi kdrguses, voib selle funktsiooni dles kirjutada.
Siin on vastav platvormi Kirjutusasend, kus to6tlemise kdrgus on vastav tihjale pliiatsi
asendile enne liikumist, platvormi tuleks nihutada vajalikule optilise tdlke tasemele, mis ei
hairiks protsessi toorikut uuesti. Kui optilist tdlget ei kinnitata ja see tooriku tootlemist ei
hairi, ei pea te pliiatsi positsiooni seadistama.
Kasutusviis:
1> Oskab kirjutamiseks pliiatsit kasutada.
2> V0ib kirjutada positsiooni, késitsi juhtpaneeli klahvi mobiilne platvorm, graafika
tootlemiseks reguleerige fookuskaugust. Seejarel kldpsake nuppu "loe" ja kirjutage seejarel
kdik seadistatud positsioonid.
3> See voib sisaldada positsiooni, kasitsi juhtpaneeli klahvi mobiilset platvormi, liikumine
optilisel tasandil ei hairi kérguse t06d ja paneeli klahvi kaudu optikale liikudes saame
Kinnitatud, et see ei hadiri muid parameetreid, vajutage klahvi "loe" ja seejérel seadistage
asukoht.

[Punkt]



Siin saab rbi ja sobib joonistamise tooriistaks sobib moni lintsam voi DXF-failist moni
lihtsam. Kihtide to6tlemismeetoditel pole vahet kas praegune kiht graveerib voi skaneerib,

lihtsamas graafikas alati olnud kasutusel rbi-valjund.
Rbi liikumiskiirus kihi Kiiruse saavutamiseks Gletab energiat maksimaalset kihttdotluse

laserienergiat.

[ Laseri lubamine]
Kui masin on varustatud kaheteelise laseriga, on tavaliselt kaks teed ja valjundit. Kuid
kasutaja vOib selle laseri seadistada nii, et see ei oleks valjund kogu tee.

[Uhine 10 valjund)
Kogu ldiketee ja kihid on seotud 10 valjundiga, kohustuslik funktsioon.

Other cutting param @

[¥] Enable sew compensation

Sew width 0.1 mm

[ Ok ] [ Cancel ]

[ Luba 8mbluskompensatsioon] : dmbluse laiuse kompenseerimise abil saab
kompenseerida laseri I18ikegraafika dmbluse suuruse ja tegeliku valjal6ike graafilist
korvalekallet.

[Omblemissuund] : vastavalt tegelikule seadistamisvajadusele, naiteks ringi I5ikamiseks,
kui soovite, et ring oleks dra I8igatud, peaksite seadma kompensatsiooni suuna véljapoole.
Kui soovite auku hoida, peaksite seadma kompensatsiooni suunaga sissepoole.

[Ombluse laius] : laserdmbluse laiuse I6ikamine méoda koepiire.



4.10.3 Laserskaneerimise parameetrid seaded

Layer Parameter [=238]| Layer Parameter 23]
[ Load parameters from library l AL | [ Load parameters from library ]
IsOuput: |Yes |~ souput: |Yes v
Speed(mm/s): 100 [T pefault Speed(mm/s): 100 ["] Default
IfBlowing: |Yes "‘ IfBlowing: | Yes (v |
Processing Mode: chan w v \ Advance... Processing Mode: |Scan v‘
Min Power{%) Max Power(%) Min Power (%) Max Power{%)
@1 30 30 [ | Default “]1: 30 30 [T Default
[@]2: 30 30 “]2: 30 30
Negative Engrave Optimized Scan [ Negative Engrave [ Optimized Scan
Qutput direct [} independent output [ output direct [} independent output
[]Ramp Effect [ Ramp Effect
Ramp Length: |0 ‘ mm Ramp Length: |0 mm
Overstriking: |Un-process ‘ v| Overstriking: |Un-process ‘ v ‘
Scan Mode: }‘rx_swing vJ Scan Mode: |X_swing Jv}
Interval(mm): 0.1 Interval(mm): 0.1
| | ok | [ cancel | - | [ ok | [ cancel |

Vektorskaneerimise parameetrite Seaded [Settings] dialoogiboks on vasakul, bittikaardi
skaneerimise parameetrite dialoogiboks Seaded [Settings] on paremas servas. Vektorandmed ei
toeta varvide graveerimist, optimeerimise skaneerimist ega otsevéljundit.

Varvide graveerimine: tavaliselt skaneerimine, mustades tappides bitikaart, laser valges. Valige
graveerimiseks Vérv, bitikaart laseri valgel, laseril mustad tapid.

Optimaalne skaneerimine: optimeerimise valimisel reguleerib kasutaja skaneerimisintervalli
automaatselt, et seadistada parim véartus, parim skaneerimise efekt.

Vastasel juhul vastavalt kasutaja skaneerimisintervalli skaneerimisseadetele. Uldjuhul vali
"optimaalne skaneerimine™

Otsevaljund: halli skaala bittkaarti tegelikule graafikale vastab hall. Valjundis on stigava koha
varvigraafika laserenergia suur, madala koha varvigraafika laserenergia on madal.

Joonis vastavalt valjundile: vektorgraafika puhul on joonise vastavalt vektorgraafiku

valjund juaani suhte positsioon, mis omakorda saab kokku vastavalt vektorkaardi

nikerdamise valjundi.



Kui seda pole margitud, on vdi valjundi skulptuuriks kogu vektorgraafika tervikuna.

Kui bittikaardi jaoks pole vastavat joonist voi véljundit, tootab stisteem automaatselt
bittikaardi kihiga kogu véljundina.

Kui see on mérgitud, on nditaja vastavalt valjund, stisteem on hes véljundis bittikaardil.
Tousuefekt: skaneerimise joonise servad naitavad tbusu, edastavad stereoefekti.

Paks kiri [Bold font]: arge kasitsege, skaneerige fonti, skaneerige alaosa. Uldjuhul valige
mitte to6tlemine.

Skaneerimisel on ks osa fondi skaneerimine, nagu on Yin nikerdusel.

Pange tahele, et tdusuefekti valikul &rge valige rasvast kirjafonti, et mitte mojutada
tousuefekti.

Font Yin nikerdus: teksti lisamine valjaspool kasti, skaneerimine on tekst ise, nagu allpool:

Font Yang nikerdus: tekst ja valimine raam, skaneerimine on graafika p&hi, nagu allpool:

M

Skaneerimisreziim: sealhulgas tasandiline ihesuunaline, tasandiline kahesuunaline,
vertikaalne hesuunaline, vertikaalne kahesuunaline.

Tasandiline Ghesuunaline: optilise skaneerimise muster edasi-tagasi horisontaalsuunas,
kuid ainult sellesse suunda, kui laserskaneerimine toimib, néiteks: optilisel skaneerimisel
laseri paremalt vasakule ja vasakult paremale.

Tasandiline kahesuunaline: optiline horisontaalne suund edasi-tagasi laserskaneerimise
graafikas.

Vertikaalne Uhesuunaline: optiline skaneerimismuster vertikaalsuunas edasi-tagasi, kuid
ainult tihes suunas toimub laserskaneerimine, nditeks: optiline skaneerimine laseri les- ja
allapoole ja laseri skaneerimine altpoolt.

Vertikaalne kahesuunaline: vertikaalsuunas optiline edasi-tagasi laserskaneerimise
graafika. Markus: tldkasutustaseme kahesuunaline skaneerimisreziim.




Skaneerimisintervall: optiline skaneerimine s6ltub graafika suurusest. Mida véiksem on
intervall, seda siigavam on graafika, ja vastupidi, mida suurem graafika, seda madalam
skaneerimisintervall.

Soovitused: (1) vektorikihi (s.o varvikihi) jaoks on skaneerimisintervall 0,1 mm ja alla selle.
(2) tutu-kihi (nimelt BMP-kihi) puhul on skaneerimisintervall 0,1 mm ja Gle selle.

Siis muuta koige suurem joud minimaalsele vdimsusele graafilise stigavuse skaneerimise
ideaalse efekti saavutamiseks.

4.10.4 Laserpunkti parameetrite seadistamine

Layer Parameter

Laver:

Is Qutput:  Yes v
Speed(mmjs): ElUU [[]Default
If Blowing: | Yes v

Processing Mode: | Dot v

Min Power(%) Max Power(%)

| Xeifs :
Laserl: |30 30 ! f
L J ‘ JI:IDe ok The time for emitting laser on
Laser2: |30 w 30 ] :
T AL - or:lldotdurlng the process. The
er the value is. the darker

/ h
Dot time: %U-l s

[17 i : ThE interval between the dots
Dot interval: t5| Tmn

Dot length: |0 —mr—>1 Do} length, for cutting dash line

[]center dw\

Onjy dot at center

[ Ok ] [ Cancel ]




4.11 Tootja seaded
4.11.1 Mootori parameetrid

XY Z U telje parameetrid

Suuna polaarsus: polaarsuse suuna muutmine v6ib panna mootori liikuma vastupidises
suunas. Muutmise eesmark on muuta telg lahtestamisel alguspunktiks, kui l&htestada, kui
telgsuund on alguspunktist eemale kaldunud ja kui polaartelje suund on valesti madratud,
siis tuleks seda muuta.

Piiraja polaarsus: kasutatakse kdrge ja madala signaali mudeli piiri méaramiseks. Kui
liikuv telg j6uab piirasendisse, sisestage pohiplaadile madala taseme signaal, piiriks tuleks
seada negatiivne polaarsus.

Laius: pikim telgede vaheline kaugus voib varieeruda, vastavalt masina tegelikule asendile.
Alguspunkti nihe: kui telg on jdigalt paigas, peaks see enamasti olema méératud vaartusega
2 ~ 5 mm, kui see on seatud véartusele 0, siis telgede koordinaatide nulljooks on
minimaalne. Efektiivselt voib sellist paastikuvea piiramise funktsiooni rakendada masina
hadaseiskamisega, kui jaiga piiri kaitsefunktsiooni ei dnnestu sisestada, saab vaartuseks
maarata 0 ~ 5 mm.

Contrl-reziim: topeltimpulss ja impulss + suuna reziim on valikuline, s6ltuvalt mootori
ajami masina tegelikust konfiguratsioonist, impulsi + suuna tldmudelist.

Sammu pikkus: mootori impulsi ekvivalent, saatke impulss mootorile, vastav liikumistelg
labi absoluutse kauguse véartuse. Enne selle vaartuse Gigesti seadistamist vdib lasta masinal
I6igata suurt ristkilikut (kui graafika on suurem, vGib teha vdiksema vea), automaatne
arvutus graafilise pikkuse jargi ja samm-mootori pikkuse mddtmine.

Piiraja sisseltlitamine: kasutatakse telje jaiga piiri kaitse funktsiooni aktiveerimiseks.
Kehtiv PWM t6ususerv: kasutatakse mootori ajamite seadistamiseks, kui impulssignaal on
tdusvaid/ langevaid servi moodda. Kui see pole sisse lulitatud, valib langeva serva regulaator
tegeliku servaefekti. Kui see on sisselilitatud, kasutage tdususerva koos efektiivse
kontrolleriga.

Alguspunkti sisseltlitamine [Enable Home]: kui masina konfiguratsioon on koos teljega,
peaks telje valik " lahtestamine lubatud " olema avatud, kui telge pole konfigureeritud, peaks
telje valik "lahtestamine lubatud” olema keelatud. Selle parameetri tdhendus on
"l&htestamise™ juhtimine buutimis/kaivitamisvalikute kontrollimine kasutaja eelistustes ja
funktsiooniklahvid telje funktsiooni " lahtestamine” juures takistavad kasutajaid ekslikult
l&htestamast volli litkumist, mida pole olemas.



Huppekiirus: volli litkumiskiirus algab otseselt statsionaarsest olekust, kui poordevaartus
on liiga suur, vOib see pdhjustada mootori podrdekiiruse véhenemist, vonke ja isegi mira
teket, ning kui seadistus on liiga madal, vdib see graafika tookiirust vahendada. Kui liikuva
vOlli inerts on suur, vOib paigaldada véiksema stardikiiruse, kui volli inertslitkumise telg on
vaiksem, saab volli poorlemiskiirust soovikohaselt suurendada. Tuupilised vaartused,
naiteks 5 ~ 30 mm/s.

Maksimaalne kiirendus: voll peab vastu maksimaalsele kiirusele. Inertsmootori ajami
vOimsus, mootori voll ja Ulekandearv vastab parameetritele. Tulpilised vaartused, naiteks
200 ~ 500 mm /s.

Max Acc: mootori voll maksimaalsel kiirendusel ja aeglustusel, kui kiirendus on liiga suur,
samuti vOib see pdhjustada mootori poordekiiruse véhenemist, vonke ja isegi mura teket,
ning kui seadistus on liiga vaike, v0ib see to0tada aeglaselt ja vahendada graafika tookiirust.
Vastavalt suurele inertsiteljele, néiteks Y-telje kiirele, on tdpiline seadistus vahemikus
800-3000 mm / s2, mis vastab vaikesele inertsiteljele, nditeks X-telje auto , tliupiline
seadistusvahemik on 8000 ~ 20000 mm / s2.

Maksimaalse kiirenduse piirang [EStop acc]: saab teha kiirusepiirangu kui voll liigub
aksiaalselt piirasendisse, et peatada t66 hadaseiskamise kaudu kiirenduse aeglustamiseks.
See vaartus voib votta maksimaalse kiirenduse alandamine 2—3 korda.

Huppekiirus: klaviatuuri klahvid telje liikumise algkiiruse muutmiseks, mitte tle volli
poorlemiskiiruse.

Acc: Nupud muudavad telje liikumise Kiirenduse vaartust, mis ei saa olla suurem Kui
maksimaalne kiirendus.

Jarjekord vastupidiseks:

Kasutatakse manuaalset nuppu liikumise juhtimiseks mobiilse litkumise telje suuna korral.
Kui seadistate polaarsuse parameetrite 6ige suuna, vajutage juhtpaneelil suuna klahvi, telje
suunda, mille nuppe saab tagasi poorata.

4.11.2 Laseri parameetrid

Laseri konfiguratsioon: (ks toru on valitud vastavalt lasertorude tootjate tegelike
konfiguratsiooniseadele.

Laseri reziim: Klaasist toru, raadiosageduslik laser (ei vaja eelp&lemisimpulssi) ja
raadiosageduslik laser (vajab eelpdlemisimpulssi) valikuline

Laseri sumbefiltrid , Minimaalne vbimsus ., Maksimaalne véimsus , Lasersagedus .
Eelstilte sagedus:



Eelsttteimpulss: raadiosagedusliku (%) laseri ja eelp&lemisimpulsi korral on sagedus ja
eelpdlemisimpulsi eelpumba laiuse konfiguratsioon pulsi eelpdletusnéitajad.

Signaali tase:

Veekaitse: veekaitse tegemiseks peab kontroller olema tihendatud veekaitse

vooluringi, ei kustu masina valgus, kui me ei tee veekaitset, &rge votke veekaitseahelat,
kontroller seda ei tuvasta.

Juhtimissignaali abil kasutatavat lasersagedust kasutatakse laseri impulsi sageduse
seadistamiseks. Klaastoru on tavaliselt seatud véartusele 20 KHZ, raadiosagedustoru
tavaliselt umbes 5 KHZ; maksimaalse / minimaalse voimsuse (%) abil méératakse laseri
vOimsuse vaartus, nimelt kéitusajal ei saa maksimaalse vdimsuse seaded olla suuremad kui
maksimaalse vdimsuse seatud vaartus, kasutaja seaded ei saa olla alla minimaalse vdimsuse
vadrtuse minimaalse voimsuse madramise jaoks. Kasutage teatud aja pérast, kui laseri
vBimsuse sumbumine on ndrgenemisteguri méaaramisel laseri vdimsuse peenhdélestuseks,
laser ilma summutuseta, sumbumistegur O.

Viip: kui konfigureeritud on (ks lasertoru, naitab see ainult laseri parameetreid.

4.11.3 Muud hankija parameetrid

Masina tutp: Enamasti peaks valima tldgraveerimismasina, konkreetse mudeli jaoks muud
mudelid.

Edastusreziim: tavaolukorras peaks valima "samm-tiiuipi v66", muu tudbi valimiseks on
juhtimisalgoritmil vaikesed muudatused.

So6tmisreziim: (ihesuunalise / kahesuunalise so6tmise valik. Uhesuunalise séétmise korral
arge kontrollige koordinaati, see on seadistatud Ghepoolselt ilespoole; Kahesuunalise
s0otmise valimisel kontrollib siisteem maksimaalseid ja minimaalseid koordinaate, paaritu
arv kordi tihes suunas, paaris arv kordi teises suunas, esimene algsuund saadakse polaarsuse
suuna positiivse ja negatiivse pikkuse vaartust muutes voi modifitseerides.

Katkestatud viivitus: saab seadistada vaartusele 0 ~ 3000 ms. Pé&rast elektrivorku lilitamist
ei vahene stisteemi toiteallikas viivitamatult O v-ni, aegviivituse ajal peaks toite seatud
viivituse vaartus olema tegeliku viivituse vaartusega pohimaotteliselt identne. Kui vaartus on
seatud nikerdustoode jatkamiseks, graafika ja graafika teiseks tootlemiseks voi pole see enne
voolu suletud voi esineb liiga palju kattumist.

Luba kaitse: kui see dnnestub, peab kontroller olema avatud ja kaitseahel Gihendatud,
vastasel juhul masin ei to6ta.



Luba puhur: kui soovite kasutada valjalaske tuule signaalikihti ja juhtida ventilaatori lilitit,
peab see parameetritele vastama, vastasel juhul tuleb tuule signaali véljund teistele
signaalidele.

Seadistusviip: Tootja konfiguratsiooniparameetrite, néiteks polaarsuse suuna
juhtimisreziimi, laser- ja lasersageduse tiitipide puhul on seadistatud neli parameetrit.
Muudatuste tegemisel on vaja stisteem taas algseadistada, et tehtud muudatused joustuksid.



Taname teid Shenzhen Rui Da Technology Co toote kasutamise eest. Selle
kasutusjuhendi kdik osad ja majanduslikud digused kuuluvad Shenzhen Rui Da
Technology Co. Meie ndusolekuta ei tohi Ukski Uksus ega Uksikisik sellega seotud sisu
uuesti printida, kopeerida ega levitada toote kasutusjuhendit. Kui toote sisu teave
muutub ilma ette teatamata.

Kasutajatel, kellel on t66pingi kasutamise ajal kasutusjuhendi kohta markusi voi
ettepanekuid, palun helistage.

Telefon: 0755-26066687 Faks: 0755-26982287

Aadress: Hoone 2-501 #, Tian’ Ani toostuspark, Nan you, Nanshani piirkond,
Shenzheni linn.

Veebisait: www.rd-acs.com



